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Preface

Audience for This Guide
Welcome to Release 11i of the Oracle Install Base Implementation Guide.
This guide assumes you have a working knowledge of the following:
= The principles and customary practices of your business area.

If you have never used Oracle Install Base, Oracle suggests you attend one or
more of the Oracle Install Base training classes available through Oracle
University.

s The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications
product information.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle Corporation is actively engaged with other
market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,



visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation JAWS, a Windows screen
reader, may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, JAWS may not always read a line of text that
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This
documentation may contain links to Web sites of other companies or organizations
that Oracle Corporation does not own or control. Oracle Corporation neither
evaluates nor makes any representations regarding the accessibility of these Web
sites.

How To Use This Guide

This document contains the information you need to implement Oracle Install Base.

s Chapter 1 provides overviews of the application, its features, functions, and
integration points with other applications.

= Chapter 2 provides details of the setup steps for new users to implement the
product.

s Chapter 3 provides details of the setup steps for upgrade users to implement
the product.

»  Chapter 4 describes the configuration of the system profile options for the
product.

Other Information Sources

You can choose from many sources of information, including online documentation,
training, and support services, to increase your knowledge and understanding of
Oracle Install Base.

If this guide refers you to other Oracle Applications documentation, use only the
Release 11i versions of those guides.

Online Documentation

All Oracle Applications documentation is available online (HTML or PDF). Online
help patches are available on OracleMetaLink.



Related Documentation

Oracle Install Base shares business and setup information with other Oracle
Applications products. Therefore, you may want to refer to other product
documentation when you set up and use Oracle Install Base.

You can read the documents online by choosing Library from the expandable menu
on your HTML help window, by reading from the Oracle Applications Document
Library CD included in your media pack, or by using a Web browser with a URL
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at
http:/ /oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate using the
graphical user interface (GUI) available with this release of Oracle Install Base (and
any other Oracle Applications products). This guide also includes information on
setting user profiles, as well as running and reviewing reports and concurrent
processes.

You can access this user’s guide online by choosing "Getting Started with Oracle
Applications" from any Oracle Applications help file.

Documents Related to This Product

Oracle Enterprise Install Base Implementation Guide
Refer to this guide to understand the implementation of a closely related product.

Oracle Telecommunications Service Ordering Process Guide

This guide provides guidance to implementers, administrative users, and end users
of the Oracle Telecommunications Service Ordering (TSO) solution for
telecommunication services and products. The purpose of the this document is to
provide the reader with an understanding of the solution, the overall user flow, the
functionality, and the setup required for each Oracle application to enable the TSO
solution.

Xi



Xii

Installation and System Administration

Oracle Applications Concepts

This guide provides an introduction to the concepts, features, technology stack,
architecture, and terminology for Oracle Applications Release 11i. It provides a
useful first book to read before an installation of Oracle Applications. This guide
also introduces the concepts behind Applications-wide features such as Business
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle
Applications products. In Release 11i, much of the installation process is handled
using Oracle Rapid Install, which minimizes the time to install Oracle Applications,
the Oracle9i technology stack, and the Oracle9i Application Server technology stack
by automating many of the required steps. This guide contains instructions for
using Oracle Rapid Install and lists the tasks you need to perform to finish your
installation. You should use this guide in conjunction with individual product
user’s guides and implementation guides.

Oracle Applications Supplemental CRM Installation Steps

This guide contains specific steps needed to complete installation of a few of the
CRM products. The steps should be done immediately following the tasks given in
the Installing Oracle Applications guide.

Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or
Release 11.0 products to Release 11i. This guide describes the upgrade process and
lists database and product-specific upgrade tasks. You must be either at Release 10.7
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i.
You cannot upgrade to Release 117 directly from releases prior to Release 10.7.

Maintaining Oracle Applications

Use this guide to help you run the various AD utilities, such as AutoUpgrade,
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and
others. It contains how-to steps, screenshots, and other information that you need to
run the AD utilities. This guide also provides information on maintaining the
Oracle applications file system and database.



Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle Applications
System Administrator. It contains information on how to define security, customize
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of
your Oracle Applications data.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle Applications
development staff. It describes the Oracle Application Object Library components
needed to implement the Oracle Applications user interface described in the Oracle
Applications User Interface Standards for Forms-Based Products. It also provides
information to help you build your custom Oracle Forms Developer 6i forms so that
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle
Applications development staff. It describes the UI for the Oracle Applications
products and how to apply this Ul to the design of an application built by using
Oracle Forms.

Other Implementation Documentation

Multiple Reporting Currencies in Oracle Applications

If you use the Multiple Reporting Currencies feature to record transactions in more
than one currency, use this manual before implementing Oracle Install Base. This
manual details additional steps and setup considerations for implementing Oracle
Install Base with this feature.

Multiple Organizations in Oracle Applications

This guide describes how to set up and use Oracle Install Base with Oracle
Applications' Multiple Organization support feature, so you can define and support
different organization structures when running a single installation of Oracle Install
Base.
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Oracle Workflow Guide

This guide explains how to define new workflow business processes as well as
customize existing Oracle Applications-embedded workflow processes.You also use
this guide to complete the setup steps necessary for any Oracle Applications
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup and reference information for the
Oracle Install Base implementation team, as well as for users responsible for the
ongoing maintenance of Oracle Applications product data. This manual also
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (eTRM) contains database diagrams and a
detailed description of database tables, forms, reports, and programs for a specific
Oracle Applications product. This information helps you convert data from your
existing applications, integrate Oracle Applications data with non-Oracle
applications, and write custom reports for Oracle Applications products. Oracle
eTRM is available on OracleMetaLink.

Oracle Manufacturing APIs and Open Interfaces Manual

This manual contains up-to-date information about integrating with other Oracle
Manufacturing applications and with your other systems. This documentation
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual

This manual contains up-to-date information about integrating with other Oracle
Manufacturing applications and with your other systems. This documentation
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual

This manual describes Oracle Applications messages. This manual is available in
HTML format on the documentation CD-ROM for Release 11i.

Oracle Common Application Components Implementation Guide

Many products use components from Oracle Common Application Components.
Use this guide to correctly implement CRM Application Foundation.



Oracle Enterprise Install Base Implementation Guide
This guide is required for the setup of the ERP integrations with Oracle Install Base.

Oracle Manufacturing Implementation Guide
This document is required for the setup of Inventory, Bills of Material, and WIP.

Oracle Service Fulfillment Manager Implementation Guide

This document is required for the setup of the Oracle SFM (Service Fulfillment
Manager) Event Queue used in the ERP integration with Oracle Install Base.

Training and Support

Training

Oracle offers training courses to help you and your staff master Oracle Install Base
and reach full productivity quickly. You have a choice of educational environments.
You can attend courses offered by Oracle University at any one of our many
Education Centers, you can arrange for our trainers to teach at your facility, or you
can use Oracle Learning Network (OLN), Oracle University's online education
utility. In addition, Oracle training professionals can tailor standard courses or
develop custom courses to meet your needs. For example, you may want to use
your organization’s structure, terminology, and data as examples in a customized
training session delivered at your own facility.

Support

From on-site support to central support, our team of experienced professionals
provides the help and information you need to keep Oracle Install Base working for
you. This team includes your Technical Representative, Account Manager, and
Oracle’s large staff of consultants and support specialists with expertise in your
business area, managing an Oracle9i server, and your hardware and software
environment.

OracleMetalLink

OracleMetaLink is your self-service support connection with web, telephone menu,
and e-mail alternatives. Oracle supplies these technologies for your convenience,
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain
information and advice from technical libraries and forums, download patches,
download the latest documentation, look at bug details, and create or update TARs.
To use OracleMetaLink, register at (http://metalink.oracle.com).

XV



Alerts: You should check OracleMetaLink alerts before you begin to install or
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows:
Technical Libraries/ERP Applications/Applications Installation and
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the
Self-Service Toolkit page as follows: Technical Libraries/ERP
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using
Oracle Applications can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a
row in one table without making corresponding changes in related tables. If your
tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps
track of who changes information. If you enter information into database tables
using database tools, you may store invalid information. You also lose the ability to
track who has changed your information because SQL*Plus and other database
tools do not keep a record of changes.

About Oracle

XVi

Oracle Corporation develops and markets an integrated line of software products
for database management, applications development, decision support, and office
automation, as well as Oracle Applications, an integrated suite of more than 160
software modules for financial management, supply chain management,
manufacturing, project systems, human resources and customer relationship
management.



Oracle products are available for mainframes, minicomputers, personal computers,
network computers and personal digital assistants, allowing organizations to
integrate different computers, different operating systems, different networks, and
even different database management systems, into a single, unified computing and
information resource.

Oracle is the world’s leading supplier of software for information management, and
the world’s second largest software company. Oracle offers its database, tools, and
applications products, along with related consulting, education, and support
services, in over 145 countries around the world.
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1

Overview of Oracle Install Base

This chapter covers the following topics:
= Summary of Oracle Install Base
=  Features of Oracle Install Base

= Integration Points and Dependencies for Oracle Install Base

1.1 Summary of Oracle Install Base

Oracle Install Base is an item instance life cycle tracking application that facilitates
enterprise-wide life cycle item management and tracking capabilities. Oracle Install
Base tracks an item from the time that it is received in inventory, in work in process,
in projects, at customer sites, and throughout the return and repair process. It
records a history of changes to tracked items and supports the creation and
maintenance of Oracle Install Base configurations.

Oracle Install Base is a centralized repository of information for an item instance
and its tracking details including location, status, ownership, party relationships,
account relationships, contact relationships, configuration data, and the change
history of customer products or corporate assets. The application includes
drill-down capability to obtain details of inventory, work in process, and order
management transactions affecting an item's tracking attributes.

Additionally, Oracle Install Base provides links to detailed information from
contracts, service requests, repair orders initiated for an item instance, and counters
associated with the item instance.
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Features of Oracle Install Base

Note: Oracle Install Base support is subject to rules, conditions,
and limitations discussed in various sections of this guide. These
are not exhaustive. Although most situations are covered, it is not
possible to specify all rules, conditions, and limitations with regard
to the functionality of the application.

1.2 Features of Oracle Install Base

1.2.1 Functional Overview

Oracle Install Base is capable of tracking serialized and non-serialized item
instances including:

Tangible products such as manufactured, purchased, and shipped items
Intangible products such as software, services, licenses, and agreements

Tangible assets including fixed, movable, and leased assets

Oracle Install Base leverages existing Oracle applications and is fully integrated
with the Oracle E-Business Suite.

Key features and functionality include the following:

Item instance maintenance

Support for inventory transactions

Centralized repository of information:

» Item instance consolidated transactions history

= Item instance timestamp and version label history

= History of Oracle E-Business Suite transactions affecting Oracle Install Base
Instance relationships with multiple party/accounts
Configuration support and instance-to-instance relationships
Open Interface and Quick Edit capabilities:

= Mass load of item instances by an open interface

= Quick online edit of attributes for a group of item instances

System grouping of item instances

1-2 Oracle Install Base Implementation Guide
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= Capability of user-defined extended attributes

1.2.2 Instance Maintenance

Oracle Install Base provides for creation, updating, querying, and copying of
instances through Oracle Install Base user interfaces and through integration with
other applications. These include Oracle applications such as:

= Oracle Service Contracts

s Oracle Field Service

= Oracle Depot Repair

s Oracle Complex Maintenance, Repair, and Overhaul
= Receiving

= Oracle Work in Process

= Oracle Inventory

= Oracle Projects

s Oracle Order Management

= Shipping

Asset creation and maintenance can be invoked using Oracle Enterprise Install Base.

It provides tracking of location, status, addresses, contacts, business party
relationships, inter-instance relationships, extended pricing, instance attributes, and
a host of other item instance attributes.

Instance maintenance can be directly performed using robust HTML query, search,
and edit capabilities.

1.2.2.1 Support for Inventory Transactions

Oracle Install Base supports creation and update of item instances and attributes for
transactions originating in Oracle Inventory. These include internal transactions
such as internal order shipments and subinventory transfers, discrete
manufacturing transactions such as WIP component issue and WIP component
return, and external transactions such as sales order shipments to external
customers.

The Oracle Install Base Implementation Guide provides a comprehensive list of Oracle
Inventory transactions that Oracle Install Base supports.

Overview of Oracle Install Base 1-3
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1.2.2.2 Centralized Repository of Information

Here are examples of information that you can find in the centralized repository
that is Oracle Install Base:

= Consolidated transactions history for an item instance

Oracle Install Base provides a single, centralized user interface to view and drill
down from all transactions affecting tracking attributes for an item over the life
of the item instance. Transaction details include, for example, transaction type,
source application, transaction, line reference, and transaction date.

= Timestamp and version label history for an item instance

In the Product History page you can view the state of the attributes of an
instance by specifying a date-time stamp or a version label. This feature
provides valuable information regarding what an item instance looked like at a
given point in time.

=  History of Oracle E-Business Suite transactions affecting Oracle Install Base

Oracle Install Base provides the ability to query transactions by date range,
status, and transaction types across Oracle E-Business Suite applications. It
pulls together information from multiple applications and presents it in a
single, central user interface.

1.2.3 Multiple Party/Account Relationships

With Oracle Install Base you can relate an item instance to multiple entities called
parties. The parties can be different party types. Thus an item instance may have
been Sold To party A but is now Owned By party B. It may be Shipped To party C,
and so on. The entities may have type values such as Party, Vendor, Employee. For
each party type, you can define relationship types such as Owner and Service
Provider. Each party can have multiple accounts.

This feature supports the multiple business relationships required by today's
business globalization and outsourcing requirements.

1.2.4 Configuration Support and Instance-to-Instance Relationships

Oracle Install Base provides the ability to store configurations of item instances and
to access the history of a configuration.

This functionality includes creating and maintaining configurations. It builds
hierarchical configurations at WIP assembly completion by formulating

1-4 Oracle Install Base Implementation Guide
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Component-Of relationships between instances. It supports parent-child bill of
material (BOM) structure at the point of sales order shipment.

Multiple types of relationships between instances are supported. For example,
Oracle Install Base connects two or more components in a communications network
by creating Connected-To relationships between item instances. This capability
reflects Oracle Install Base integration with the Oracle Telecommunications Service
Ordering solution of Oracle Configurator.

1.2.5 Open Interface Mass Load and Mass Edit Capabilities

Oracle Install Base provides the Open Interface feature to mass load item instances.
This is useful during initial conversion and for synchronizing multiple
environments. It can be used to create new instances or to update existing item
instances. It can also be used to create or update relationships between item
instances including replacing instances in Component-Of configurations.

Additionally, Oracle Install Base provides the handy, out-of-the-box Mass Edit
feature. With this feature you can select a group of item instances based on a set of
search criteria and invoke attribute changes for all item instances in the group. For
example, you can quickly and conveniently change ownership, location or contacts
for a group of instances. The transactions can also be set to run on a future date.

1.2.6 System Grouping of ltem Instances

Oracle Install Base has the ability to group item instances under a construct called a
system. For example, all copier machines on the fifth floor of a building or those
belonging to a specific department can be grouped under a system. You can define,
view, and invoke specific changes to item instances within the system, or grouping.
Additionally, you can build hierarchies of systems and link multiple systems in
parent-child hierarchies or relationships.

1.2.7 Extended Attributes

Oracle Install Base offers the flexibility of multi-level, user definable additional, or
extended, attributes associated with an item instance to fit a variety of business
requirements. The application also stores pricing attributes for an item instance and
makes them available for subsequent use by Oracle E-Business Suite applications
including Oracle Service Contracts. That application uses service programs or
extended warranties where price is dependent on the attributes of a product.
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1.3 Integration Points and Dependencies for Oracle Install Base

1.3.1 Integration with the Oracle E-Business Suite

Oracle Install Base has the following integration points within the Oracle E-Business
Suite:

Counters and Notes (update capabilities)

Direct updates from Oracle Field Service and Oracle Complex Maintenance
Repair, and Overhaul

View and reference accessibility from multiple applications such as Oracle
Contracts, Oracle Field Service, Oracle Depot Repair, and Oracle Customer
Support

Oracle Trading Community Architecture for querying parties and accounts and
building item instance to party relationships

Oracle Inventory (receiving and other inventory transactions)
Oracle Order Management (shipping, fulfillment, and RMA receipts)

Oracle Assets (Oracle Enterprise Install Base-specific updates through mass
additions

Oracle Projects (Oracle Enterprise Install Base-specific updates to projects)

Oracle Work in Process (move transactions, assembly completion, configuration
support, and others)

Oracle Project Contracts (shipment transactions)

Trading Community Architecture (TCA) party for party and relationship

Note the following points with regard to integration with TCA and Oracle Quoting:

When using the TCA merge routines with Oracle Install Base records, Oracle
recommends that the party merge be done before the account merge. In
addition, the internal party that is set up in the Oracle Install Base parameter
cannot be used in the merge. For details, refer to Section 2.5.1 in this document.

When entering a quote, you can invoke the transaction detail to enter additional
information for Oracle Install Base. When the quote becomes an order, the
transaction detail is copied against an Oracle Order Management order. This is
processed when the order is shipped as described in the Oracle Order
Management integration.
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The application uses the Service Fulfillment Manager (SFM) event queue for
communicating transactional updates from Oracle Inventory to Oracle Install Base.

1.3.2 Inventory Receipt and Purchase Order Receipt

If an item is set up as trackable in Oracle Install Base, then an inventory receipt such
as miscellaneous receipt or PO receipt causes the creation or update of an Oracle
Install Base instance. At the time the inventory transaction happens, a message is
sent to the SFM Event Queue. It is automatically dequeued and processed to update
Oracle Install Base. Refer to Oracle Enterprise Install Base Implementation Guide and
Oracle Enterprise Install Base User Guide for more information.

For non-serialized items, if an instance already exists at the same subinventory
location, then it is added to the quantity of the instance with the same subinventory
location. If an instance for the same item subinventory location does not exist, then
a new instance is created.

If an item is serial controlled at receipt or is predefined, then an instance is created
for it with quantity of 1 with location in the subinventory location.

If an item is serial controlled at order issue, then it is treated as a non-serialized
controlled item in inventory. Only at order-issue time, when it gets a serial number,
is an instance with the serial number created.

1.3.3 Inventory Transactions

If an Oracle Install Base trackable item has been received into inventory and an
Oracle Install Base instance has been created, then any subsequent inventory
transactions will be tracked in Oracle Install Base as well.

For an inventory transfer or move order transaction, the location of an instance is
updated to reflect the new location for a serialized item. For a non-serialized item,
the quantity of the instance at the From location is subtracted, and the quantity of
the instance at the To location is increased by the quantity being moved. If the item
is issued to a WIP job, then the location of the item reflects the WIP job number. If it
is issued to an asset, then it reflects the asset number. If it is issued to a project/task,
then the location of the instance shows the project and task number. Refer to Oracle
Enterprise Install Base documentation for more details.

Supported Oracle Inventory transactions are as follows:
» Internal Order Issue

s Project Contract Issue
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= Return To Vendor

= Sales Order Issue

s Account Issue

= Move Order Issue

= Wip Component Issue
= Account Alias Issue

= Miscellaneous Issue

s Project Borrow

= Project Transfer

= Project Payback

= Move Order Transfer
= Internal Order Xfer

= Cycle Count Transfer
= Physical Inv Transfer
= Subinventory Transfer
= Backflush Transfer

= Int Order Direct Ship
= Direct Org Transfer

s Cycle Count Adjust

= Physical Inv Adjust

= Int Req Intr Rept

= Intransit Receipt

= Int Order Intr Ship

= Intransit Shipment

s Po Receipt

= Account Receipt

= Wip Component Return

= Account Alias Receipt
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= Rma Receipt

= Miscellaneous Receipt
= Sales Order Pick

= Internal Order Pick

= Po Rcpt Adjust

= Int Req Rept Adjust

= Shipment Rcpt Adjust
= Wip Assy Completion
= Wip Assembly Return
s Wip Neg Comp Issue
s Wip Neg Comp Return
= Lot Split

s Lot Merge

= Lot Bonus

= Lot Translate

= Lot Update Quantity

The work-in-process inventory-sourced transactions are described in further detail
in Section 1.3.5, "WIP Integration".

1.3.4 Oracle Order Management Integration

The integration with Oracle Order Management is the only ERP integration that
implements the functionality of Oracle Install Base installation detail. This includes
RMA receipt, sales order shipment, and sales order fulfillment. The functionality of
Oracle Install Base installation details is not supported for internal sales orders.

1.3.4.1 RMA Receipt

An RMA return receipt generates an inventory receipt material transaction in the
Inventory application. If a serialized item never existed in Oracle Install Base, then
the RMA receipt creates a new instance with the location in inventory. For
non-serialized items, first create the instance with the required quantity using the
Oracle Install Base user interface and then reference it in the RMA. If the instance
already exists in Oracle Install Base, then this return can cause a change of location
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to inventory and other changes such as status and owner as specified in the
transaction type setup used to process the transaction.

In the sales return line, installation detail can be invoked to specify additional
details for this instance and other related instances for this update to Oracle Install
Base.

Oracle Install Base supports the Order Management RMA fulfillment process for
non-shippable items under specific terms and conditions. Important conditions
include the following:

s The item must be flagged as Oracle Install Base trackable.

= Instance Reference must be entered in the Transaction (Installation) Details
window for Oracle Install Base update.

= RMA - Oracle Install Base interface workflow customizing is required.

Oracle Install Base supports RMA fulfillment by one or more of the following
events:

= Reduction in quantity (If the quantity is reduced to zero, then it is automatically
expired.)

= Instance expiration
s Change in status
= Change in configuration relationship

Instance attributes are updated based on the associated transaction types in the
transaction details window.

Refer to Section 1.3.9 for information on the use of transaction detail. To use
transaction detail, the transaction types being used have to be previously set up.
Refer to Section 2.5.24 for instructions on setting up transaction types.

1.3.4.2 Sales Order Shipment

For an Oracle Install Base trackable, shippable item, a shipping transaction
generates an inventory issue transaction in the Oracle Inventory application.

For a serialized item already in inventory, this transaction causes a change of
location and ownership, depending on the transaction type being used.

For items serialized at sales order issue, the first-time shipment transaction causes
the creation of a new instance with the serial number. If it has trackable
components, then the component instances and component-of configuration for
these components are built as well.
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For non-serialized items, the quantity is subtracted from the instance at the
inventory location, and a new instance is created with the customer ownership and
location.

Configuration Creation at Sales Order Shipment

Oracle Install Base supports Oracle Order Management integration based creation
of configurations for the following;:

= Assemble-to-order (ATO) models, configured item, ATO option class and
components

s Pick-to-order (PTO) models, included item, PTO option class and components
» Kits and components items

It is important to note items must be Oracle Install Base trackable, and
non-shippable items must be fulfilled in order to be represented in a configuration.

BOM Based Configurations

Key Rule: Configurations are built only for a parent item instance with Quantity =
1.

Oracle Install Base supports the creation of BOM based configurations at initial
shipment. Component-of relationships are created between trackable parent and
component instances.

Notes Regarding PTO and ATO Models

The creation of a PTO model is supported as in previous versions of Oracle Install
Base. At the time of sales order line processing, Oracle Configurator enables the
selection of optional items to be put into the PTO model. As a result, additional
sales order lines are created for the mandatory and optional items. If they are Oracle
Install Base trackable, then at the time of sales order shipment, instances of the top
model, the trackable components, and the component-of relationships are created in
Oracle Install Base. The PTO model need not be serialized controlled.

In all cases, at the sales order line for a sales order, installation detail can be invoked
to specify additional details for this instance and other related instances, for this
update to Oracle Install Base. Refer to Section 1.3.9 for information on the use of
installation detail.

To use the installation detail, the transaction types being used have to be previously
set up. Refer to Section 2.5.24 for instructions on setting up transaction types.
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The creation of an ATO model is supported as well. At the time of sales order line
processing, Configurator enables the selection of optional items to be put into the
ATO model. Then a WIP job can be created for the configured item to be built in
WIP. At the time of WIP assembly completion, the configured item instance and its
configuration are created with the location in inventory. When it is shipped, the
location and ownership will be changed to that of the customer. The ATO model
need not be serialized controlled.

1.3.4.3 Sales Order Fulfillment

Oracle Install Base supports sales order line fulfillment of non-shippable, trackable
items. Workflow customizing is required. Details are provided in subsequent
sections.

Fulfillment of an order line invokes the Oracle Install Base interface and
appropriately creates or updates Oracle Install Base item instances.

Configuration Creation at Sales Order Fulfillment

Oracle Install Base supports creation of the following configurations based on
integration with Oracle Order Management:

s PTO models, included items, PTO option class and components

» Kits and components items

= BOM-based configurations

Key Rule: Configurations are only built for a parent item instance with Quantity =
1.

Oracle Install Base supports the creation of BOM-based configurations at
fulfillment. Component-of relationships are created between trackable parent and
component instances.

In all cases, at the sales order line for a sales order, transaction detail can be invoked
to specify additional details for this instance and other related instances for this
update to Oracle Install Base. Refer to Section 1.3.9 for information on the use of
transaction detail.

To use the transaction detail, the transaction types being used must have been
previously set up. Refer to Section 2.5.24 for instructions on setting up transaction

types.
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1.3.5 WIP Integration

Oracle Install Base supports and reflects the majority of inventory transactions
sourced from WIP jobs and WIP transactions including component-of configuration
creation at WIP assembly completion. Section 1.3.4 provides The list of supported
transactions

WIP assembly completion creates a receipt and a subsequent transaction in Oracle
Inventory. The Oracle Install Base integration point with WIP is strictly through the
inventory material transaction, not through any internal WIP transactions.

Assembly Completion and Allocation

The creation of Oracle Install Base configurations in the context of WIP integration
is determined by several variables including auto allocate parameter, genealogy
enabled, single versus multiple job assembly quantity, serial control, trackable
components, and others.

In general configurations are created subject to Rule 1 below.

Rule 1

For auto allocate = “Y” and genealogy not enabled, configurations are built based on
job requirements. Generally, excess component quantity is not attached to a
configuration. Excess quantity is only attached if there is no job requirement.

Other considerations include the following:

= Configurations are only built for serialized assemblies (serialized at receipt or
predefined).

= Components are added or removed from existing configurations following
post-completion transactions. (For example, WIP component issue/return and
WIP negative component issue/return)

= Oracle Install Base provides configuration support for work order-less WIP
completions.

= Configurations (component removal and installation) are not supported at
assembly completion for CMRO WIP jobs.

For assembly quantity = 1, configurations are created and modified based on issued
component quantities. An exception is the following repair/upgrade scenario: If
item/serial number A is issued to a job and job completion creates the same

item /serial number or the same item with a new serial number B, then the original
serial number A is not created as a component of itself (original serial number A or
new serial number B).
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For multi-quantity assembly jobs, configuration creation is governed by the Auto
Allocate install parameter: Auto Allocate = ‘Y’ and genealogy not enabled.

For serialized components:

= Completion configuration is based on a random allocation (order of serial
numbers) in the ratio of total job component quantity required to job assembly
quantity, if job requirements exist. If no job requirements exist, then
configuration is based on component quantity issued to job assembly quantity.
Excess quantity is randomly issued.

= Post component issues are added based on ratios specified in job material
requirements, subject to Rule 1.

For non-serialized components:

= Component issues are added based on quantity required to job quantity if job
requirements exist. Otherwise, component issues are based on quantity issued
to job quantity if no requirements exist.

= Post component issues are added based on ratios specified in job material
requirements. Auto Allocate = ‘N’ and genealogy enabled.

For serialized components:

= Configuration is created according to genealogy or from the parent serial
number in the MTL table.

= No random allocation is performed.
For non-serialized components:
= Configuration relationships are built only for specific quantity allocations.

= Only a single level configuration is built for a given WIP job. To process
multiple levels of configuration, multiple jobs must be created and executed for
subassemblies.

At the time of sales order shipment, the ownership and location are changed to that
of the customer, depending on the transaction being used. Key supported WIP
transactions include:

= WIP Component Issue
= Wip Component Return
= Wip Negative (Wip-ve) Component Issue

= Wip-ve Component Return
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= Wip Assembly Completion
= Wip Assembly Return

1.3.6 Support for Internal Sales Orders

The internal sales order is one of the means for transferring items between internal
organizations. Oracle Install Base supports the internal order process subject to
specific rules and conditions. It updates item instances for internal order
transactions including internal order pick, internal order in-transit shipment,
internal order direct shipment and internal order in-transit receipts.

The key condition affecting Oracle Install Base support for internal sales orders
requires selection of the Oracle Inventory Oracle Install Base tracking parameter at
item master level. Items must be selected as Trackable for all organizations.
Similarly, lot, locator, revision, and others must be set at the master level. Generally
Oracle Install Base supports organization-level serial control combinations provided
by Oracle Inventory. Specific conditions such as serialized at receipt item in Org A
to serialized at sales order issue item in Org B are not supported.

In general, Oracle Install Base updates the following item attributes in the internal
sales order process.

Serialized Items:

Inventory Location attributes (Organization ID, Sub-inventory, Location, Locator,
Lot) are appropriately updated to reflect the transferred organization.

Non-Serialized Items:

Instances may be created and/or updated (quantity decreased/increased)
appropriately based on whether instances exist, negative quantities are allowed,
and so on.

In-Transit Internal Order Shipments:

= Instance usage and location type are updated to ‘In-Transit” at shipment subject
to serial /no-control rules.

= Instance usage and location type are updated to ‘In-Inventory’ on receipt
subject to serial /no-control rules.

Direct Internal Order Shipments:

Instance usage and location type are updated to ‘In-Inventory”’ subject to
serial /no-control rules.

Inter-Organization Transfers:

Overview of Oracle Install Base 1-15



Integration Points and Dependencies for Oracle Install Base

These generally are subject to the same rules and processes listed earlier in this
section.

1.3.7 Asset Integration

For information about asset integration, refer to Oracle Enterprise Install Base
Implementation Guide and Oracle Enterprise Install Base User Guide.

1.3.8 Project Integration

For information about project integration, refer to Oracle Enterprise Install Base
Implementation Guide and Oracle Enterprise Install Base User Guide.

1.3.9 Use of Transactions Details

The Transaction Details window is used to capture additional information that is
used to update the instance, an RMA return line, and a sales order line.

The Transaction Details can be activated on the sales order line window by clicking
Actions and selecting Installation Details. For a full description of this window, refer
to "Using the Transaction Details Window" in Oracle Install Base User Guide and
online help.
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Implementation and Setup for New Users

This chapter provides implementation and setup information for new users of
Oracle Install Base. Refer to Chapter 3 if you have an earlier version of this
application and are upgrading to this version.

This chapter covers the following topics:

Product Dependencies and Requirements

Setup Checklist for New Users

Related Setup Steps within Other Oracle Applications
Related Setup Steps within Oracle Enterprise Install Base
Setup Steps within Oracle Install Base

2.1 Product Dependencies and Requirements

The following modules must be installed and set up for Oracle Install Base to work.
Refer to the appropriate guides to install and set up these modules:

Oracle Inventory

Oracle Enterprise Install Base
Oracle Service Fulfillment Manager
Oracle Order Management

Oracle Purchasing (Optional)
Oracle Accounts Receivable

Oracle Work in Process (Optional)
Oracle Bills of Material
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2.2 Setup Checklist for New Users

This following table provides a checklist of setup steps for new users of Oracle
Install Base.

Table 2-1 Setup Checklist for New Users of Oracle Install Base

Step Required or Section
Number Title Optional Seeded? Extensible? Reference
1. Synchronize On-Hand Required NA NA Section 2.3.1

Balance with Oracle
Inventory
2. Set Up Inventory Serial Required NA NA Section 2.3.2
Control at the Master
Level
3. Set Up Oracle Install Base ~ Required NA NA Section 2.3.3
Items in the Item Master
4, Set Up Parties Required N N Section 2.3.4
5. Set Up Vendors Optional N N Section 2.3.5
6. Set Up Employees Optional N N Section 2.3.6
7. Set Up Party Accounts Required N N Section 2.3.7
8. Set Up Party Contacts Required N N Section 2.3.8
9. Verify the Setup of the Required N N Section 2.3.9
Oracle Service Fulfillment
Manager Event Queue
10. Set Up the Action Menuin Required N N Section 2.3.10
Oracle Order Management
11. Set Up the Order Required N N Section 2.3.11
Management Workflow for
Non-Shippable Items
12 Run the License Manager  Required N N Section 2.4.1
Program
13. Verify the Setup of Four Required N N Section 2.4.2
Profile Options for Oracle
Enterprise Install Base
14. Verify Location IDs in HZ_  Required Y N Section 2.4.3

LOCATIONS
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Table 2-1 Setup Checklist for New Users of Oracle Install Base

Step Required or Section
Number Title Optional Seeded? Extensible? Reference
15. Verify Codes for Asset Optional Y N Section 2.4.4
Update Statuses

16. Set Up Installation Required N N Section 2.5.1
Parameters

17. Set Up Codes for Required Y Y Section 2.5.2

Party-Account and
Party-Contact Relationship

Types

18. Verify Codes for Instance ~ Required Y N Section 2.5.3
Relationship Types

19. Verify Extended Required Y N Section 2.5.4
Attribute-Level Codes

20. Set Up Extended Attribute Optional N Y Section 2.5.5
Pools

21, Set Up Extended Attribute Optional N Y Section 2.5.6
Classifications

22, Set Up Extended Optional N Y Section 2.5.7
Attributes

23, Verify Accounting Required Y N Section 2.5.8
Classification Codes

24, Set Up Instance Type Optional N Y Section 2.5.9
Codes

25, Verify Codes for Instance ~ Required Y N Section 2.5.10
Location Sources

26. Verify Party Sources Required Y N Section 2.5.11

27. Set Up Codes for Required Y Y Section 2.5.12
Instance-Operating Unit
Relationship Types

28. Set Up Version Labels Optional Y Y Section 2.5.13

29. Set Up System Type Codes Required N Y Section 2.5.14

30. Set Up Split Process Optional N Y Section 2.5.15
Reasons
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Table 2-1 Setup Checklist for New Users of Oracle Install Base

Step Required or Section
Number Title Optional Seeded? Extensible? Reference
31. Verify Oracle Configurator Required Y N Section 2.5.16
Enabled Values

32, Verify Instance Class Required Y N Section 2.5.17
Values

33. Verify Values for the Required Y N Section 2.5.18
Resubmit Interface Process

34. Verify Values for CSI: Required Y N Section 2.5.19
Propagate Systems
Changes

35. Set Up Regions for the Optional Y N Section 2.5.20
Advanced Search Page

36. Set Up the Results of the =~ Optional Y N Section 2.5.21
Search Products Page

37. Set Up Instance Statuses Required Section 2.5.22

38. Set Up Source Transaction Required Y Y Section 2.5.23
Types

39. Set Up Transaction Required Y Y Section 2.5.24
Subtypes

40. Set Up the Transaction Required Y N Section 2.5.25
Subtypes LOV from
Non-Service Processes

4. Verify Transaction Status ~ Required Y N Section 2.5.26
Codes

42, Verify Transaction Error Required Y N Section 2.5.27
Source Types

43. Create Business Users Required N N Section 2.5.28

44. Create Agent Users Required N N Section 2.5.29

45, Schedule the Install Base ~ Required N N Section 2.5.31
Open Interface Program

46. Schedule the Initiate Mass Required N N Section 2.5.32
Edit Program

47. Schedule the Process Mass Required N N Section 2.5.33

Edit Program
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Table 2-1 Setup Checklist for New Users of Oracle Install Base

Step Required or Section
Number Title Optional Seeded? Extensible? Reference
48. Schedule the Process Old ~ Required N N Section 2.5.34
Order Lines-Fulfillable
Only Program

49, Schedule the Resubmit Required N N Section 2.5.35
Interface Process

50. Schedule the Resubmit Required N N Section 2.5.36
Waiting Transactions
Program

51. Final Synchronize Required NA NA Section 2.5.37

On-Hand Balance with
Oracle Inventory

2.3 Related Setup Steps within Other Oracle Applications

2.3.1 Synchronize On-Hand Balance with Oracle Inventory

To maintain life-cycle tracking for all items that are to be tracked in Oracle Install
Base, it maintains a mirror image of what is in Oracle Inventory. For new
implementations of Oracle Install Base, all on-hand quantities of Oracle Install Base
trackable items must be issued out of Oracle Inventory. Oracle suggests that you use
the miscellaneous issue transaction in Inventory to do this step.

You receive these items back into Inventory at Step 51 in the checklist. Refer to
Section 2.5.37 for related information.

2.3.2 Set Up Inventory Serial Control at the Master Level

Oracle Install Base requires that the serial control of Oracle Install Base trackable
items is set up in the master organization for Oracle Install Base to support the
continuous tracking through all organizations. For instructions on how to do this,
consult the Oracle Inventory User’s Guide, Volumes 1 and 2.

2.3.3 Set Up Oracle Install Base Items in the ltem Master

All items that need to be tracked in Oracle Install Base and Enterprise Install Base
are set up as Oracle Install Base trackable, whether they are tangible,
inventory-transactable, shippable items such as a computer or intangible,
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non-inventory-transactable, non-shippable items such as a license. An item can be

either Oracle Install Base trackable or a service item such as a contract. It cannot be
both.

For an item to be set up as trackable in Oracle Install Base, the Install Base Tracking
checkbox must be selected on the Service tabbed page of the Master Item window.
The navigation is Inventory > Items > Master Items. Depending on the revision of
the Oracle Inventory application, Install Base Tracking may not be on the Service
tabbed page. In this case, select Network Logistics Trackable on the Inventory
tabbed page of the Master Item window. This item attribute must be controlled at
the master inventory organization level only.

To create a warranty for a product instance, the service item of the contract must be
part of the BOM of the top assembly item.

Instances can be created online and through interfaces such as Inventory receipt and
WIP assembly completion.

Refer to Section 1.3.1, "Integration with the Oracle E-Business Suite" for information
about instance creation through integration.

For more information about how to set up items in Item Master, consult the Oracle
Inventory User’s Guide, Volumes 1 and 2.

2.3.4 Set Up Parties

The parties associated with item instances in Oracle Install Base need to be defined
in HZ_PARTIES first.

For more information about how to set up parties, consult the Oracle Accounts
Receivable Implementation Guide.

2.3.5 Set Up Vendors

The vendor parties associated with item instances in Oracle Install Base need to be
defined in PO_VENDORS first. For more information about how to set up vendors,
consult Oracle Purchasing implementation guides.

2.3.6 Set Up Employees

Employees can be associated with Oracle Install Base item instances as parties. To
do so, employees must be defined in HR tables first.

For more information about how to set up employees, consult Oracle Human
Resources Applications implementation guides.
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2.3.7 Set Up Party Accounts

The parties associated with item instances in Oracle Install Base can have a number
of accounts associated with them. These accounts need to be defined in the HZ_
CUST_ACCOUNTS table before referencing them in Oracle Install Base.

For more information about how to set up party accounts, consult the Oracle
Accounts Receivable Implementation Guide.

2.3.8 Set Up Party Contacts

Oracle Install Base can maintain the contacts to parties associated with item
instances. These contacts to parties must be defined in the HZ_PARTIES table using
the Contact Center window before referencing them in Oracle Install Base.

For more information about how to set up party contacts, consult the Oracle
Accounts Receivable Implementation Guide.

2.3.9 Verify the Setup of the Oracle Service Fulfillment Manager Event Queue

For instructions on setting up the Oracle Service Fulfillment Manager Event Queue,
refer to the Oracle Service Fulfillment Manager Implementation Guide.

Oracle Install Base is dependent on the SFM Event Manager Queue Service. The
setup steps for the SFM Event Manager Queue Service are listed below.

SFM Installation & SFM Post-Install Steps (One-Time)

It is critical that the Generic Service Management (GSM) post-install steps are done
correctly. Otherwise, the SFM Event Manager Queue Service will not be activated.
Contact Oracle Customer Support for a list of specific patch requirements.

Additional Manual Installation Step (One-Time)

SFM provides a Queue Console with which a DBA can see the number of events
sitting in the Event Manager Queue Service. When SFM is installed in Shared Mode,
which is the case for Oracle Install Base, the Queue Console form must be manually
compiled. This form is in $XDP_TOP/forms/US/XDPADQCS.fmb.

Deactivate Services that Are Not Used (One-Time)

When a DBA starts the Internal Concurrent Manager (ICM), this automatically
starts SFM Services that are registered with GSM. Because Oracle Install Base is
using only the SFM Event Manager Queue Service, all other SFM Services can be
deactivated. To do this:
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Steps

1.
2.
3.

Log into Oracle Applications with SFM System Administrator responsibility.
From the Navigator menu, select Concurrent > Administer Manager.

Deactivate all services that appear except the SFM Event Manager Queue
Service.

Setup to ensure the Serializability of transactions processed in Oracle
Install Base (One Time)

At any one time several transactions originating from Inventory and Order
Management can be processed in Oracle Install Base. To eliminate the errors that
can occur due to the concurrent execution of these transactions, the following steps
must be performed to ensure the serilizability of these transactions:

Steps

1.

o g 0 b

Log into Oracle Applications.

Navigate to System Administrator > Concurrent > Manager > Define.
Query for the Manager SFM Event Manager Queue Service.

Click Work Shifts.

Change the processes to 1.

In the Parameter field, change the value of XDP_DQ_INIT_NUM_THREADS to
1 (XDP_DQ_INIT_NUM_THREADS=1).

Stop and restart the SFM Event Manager Queue.

Monitor SFM's Event Manager Queue Service (Daily Basis)

If a DBA wants to check whether SFM's Event Manager Queue Service is running,
this can be done from any of the following places:

SFM's Queue Console - this provides the status as well as the queue size.
Concurrent Manager's Administer Manager Form - this provides the status.

Oracle Application Manager's SFM page - this page is in HTML. It allows a
DBA to see the Event Manager Queue Service status and Queue Size.
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2.3.10 Set Up the Action Menu in Oracle Order Management

This menu setup is required so that Transaction Details and Maintain Systems
windows are set up as part of the Action menu.

Steps
1. Log on to Oracle Applications with the System Administrator responsibility.

2. Choose Applications > Menu.
3. Choose View > Query By Example > Enter.
4. In the Menu field, enter the string ONT_SALES_ORDERS.
5. Choose View > Query By Example > Run.
6. Go to the last record in the multi-record details block.
7. Choose File > New to create new records with the following Field Values:
a. Seq: Choose the next sequence.
b. Function: Select Installed Base Transaction Details from the list of values.
c. Seq: Choose the next sequence.
d. Function: Select IB Maintain Systems from the list of values.

8. Save the record.

2.3.11 Set Up the Order Management Workflow for Non-Shippable ltems

Oracle Install Base creates instances when tangible items are received into
inventory. It tracks tangible items, for example, as they move between locations in
inventory, when they are shipped to customers, and when they are returned to an
enterprise. Inventory is a key driver enabling Oracle Install Base tracking of tangible
items.

Tracking intangible items, which are non-shippable and non-stockable, requires a
separate procedure because Oracle Install Base has no direct interaction with
inventory.

Generally, intangible or fulfillable items are created and tracked commencing with
sales order fulfillment. This requires integration with Oracle Order Management.
The integration provides Oracle Install Base with information regarding fulfilled
sales order lines. The integration is achieved by modifying Oracle Order
Management order line workflows. The information below provides detailed steps
to accomplish the modification.
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The following two main steps are required to modify order line workflows to enable
Oracle Install Base tracking for non-shippable items:

1. Set up Oracle Workflow Builder

2. Set up Oracle Order Management transaction types

2.3.11.1 Set Up Oracle Workflow Builder

The Workflow Builder setup is done in Oracle Workflow Builder. Use this
procedure.

Steps
1. Log on to Oracle Workflow Builder on your client PC.

2. Double click the Workflow Builder icon.
3. Select File > Open > Database.

4. Enter username apps, your apps password, and the connect string for your
database instance.

5. Click OK.
6. Select OM Order Line from the Show Item Types window.

7. Click the << button to move to the Visible list, and click OK. The Navigator
window opens.

8. Expand the list in the Navigator window by clicking the + sign.
9. Click OEOL / OM Order Line to select it.
Now you are ready to add a new function.

10. Choose Edit > New > Function from the menu. The Function Properties
window appears.

11. Enter the following details in the Activity tabbed page:
s Internal Name: NSTALL_BASE_INTERFACE
= Display Name: Install Base Interface
= Description: Oracle Install Base interface for fulfillable order lines
»  Function Name: CSI_ORDER_FULFILL_PUB.FULFILL_WF
= Function Type: PL/SQL
= Result Type: <None>
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12.

13.

14.
15.
16.

17.

18.
19.
20.
21.

22.
23.
24,

25.

In the Details tabbed page, ensure that values are set as follows:
s Error Item Type: WFERROR

m  Error Process: RETRY_ONLY

= On Revisit: Reset

Click OK.

Now you are ready to create a new process and assign the new function to the
process.

Select Processes.
Right click the order line flow that you want to customize and choose Copy.

Right click again and choose Paste. This opens the Processes Properties
window.

Enter a different Internal Name and Display Name for the newly created
process, and click OK.

Double click the newly created process to open it.
Click the New Function icon on the top icon bar.
Click the Internal Name LOV, and choose INSTALL BASE INTERFACE.

Delete the line after the Fulfill function. This line is the one going from Fulfill to
the node after Fulfill.

Insert Install Base Interface after the Fulfill function.
Right click Fulfill, and drag it to Install Base Interface.

Right click Install Base Interface, and drag it to the node after Fulfill. For option
results, choose Any.

Save your work and exit.
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Note: This customization must be done for fulfill-only order line
workflows. They are those without shipping activity as, for
example, a Bill Only or Line Flow — ATO Model.

The same process must be followed for return lines, which are those
without a receipt activity in the order line workflow. The process is
required for a non-shippable RMA interface to Oracle Install Base
as, for example, the seeded process Line Flow — Return for Credit
Only.

2.3.11.2 Set Up Oracle Order Management Transaction Types

Use this procedure to set up the required transactions types in Oracle Order
Management.

Steps

1.

@ o9 » w N

Using the Order Management Super User responsibility, navigate to Setups >
Transaction Types.

Query the desired transaction types that you plan to use on the sales orders.
Click Assign Work Flows.

End date appropriate seeded line types using seeded workflows.

Create another record with the same line type (expired record).

Assign Modified Workflow process, for example, CSI Line Flow-Generic,
created in Oracle Workflow Builder, to this line type.

7. Save your work and exit.

2.3.11.3 Process Sales Orders for Non-Shippable ltems

After the two main setup steps are complete, sales order lines using newly
customized workflows have an interface to Oracle Install Base. Use this procedure
to process sales orders for non-shippable items.

Steps

1.

Place an order for a non-shippable item through Oracle Order Management
using the customized line type created in the previous section.

Book the sales order.

Schedule or run the Oracle Order Management Workflow background process.
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4. View the instance created in Oracle Install Base.

2.4 Related Setup Steps within Oracle Enterprise Install Base

2.4.1 Run the License Manager Program

Run this program to license Oracle Enterprise Install Base only if you have not
installed Oracle Enterprise Install Base. It enables Oracle Enterprise Install Base
functionality for inventory receipts and other processing required for Oracle Install
Base.

2.4.2 Verify the Setup of Four Profile Options for Oracle Enterprise Install Base

This is required only if you have not installed Oracle Enterprise Install Base.
Confirm that the following profile options were set up:

s MO: Operating Unit (default operating unit)
»  CSE: Debug Option (Y or N)

= CSE Debug Log Directory (path name)

= CSE Bypass Event Queue (N)

2.4.3 Verify Location IDs in HZ_LOCATIONS

The following locations must be defined in the HZ_LOCATIONS table before using
them in Oracle Install Base:

Table 2-2 Locations that Must Be Defined in the HZ_LOCATIONS Table

Location Description

Project A fixed location ID defined for Projects in HZ_LOCATIONS
table.

WIP A fixed location ID defined for WIP in HZ_LOCATIONS table.

IN_TRANSIT A fixed location ID defined for In-transit in HZ_LOCATIONS
table.

PO A fixed location ID defined for PO in HZ_LOCATIONS table.
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These fixed location IDs must be defined in HZ_LOCATIONS first before setting up
the Installation Parameters in a later step. For more information about how to set up
locations, consult the Oracle TeleService Implementation Guide.

2.4.4 Verify Codes for Asset Update Statuses
Type: CSI Lookup
Lookup Type: CSI_ASSET_UPDATE_STATUS
Access Level: System (non-extensible)
Verify that the following values are already seeded for CSI_ASSET_UPDATE_
STATUS.

Table 2-3 Seeded Values for CSI_ASSET_UPDATE_STATUS

Lookup Code Meaning Description
IN-SERVICE In-Service In-Service
RETIRED Retired Retired

Refer to the Oracle Enterprise Install Base Implementation Guide for details.

2.5 Setup Steps within Oracle Install Base

Most of these steps are performed through navigation to Oracle Install Base Setups
and Lookups. You access these through the Oracle Installed Base Admin
responsibility. Online help for the Install Base Lookups window provides
information about lookups. The left pane of the Functions tabbed page of the Oracle
Installed Base Admin window appears with the the following entries:

= Mass Edit
s Transaction Errors Processing
= Open Interface Error Details
= Setups
= Install Parameters
= Instance Relation Types
s Party Account Relation Types

s Transaction Types

2-14 Oracle Install Base Implementation Guide



Setup Steps within Oracle Install Base

= Source Transaction Types
» Extended Attribute Template
= Instance Statuses
s Asset Location Setup
= Maintain Locations
s Others
= Requests
= Reports
= Lookups

Figure 2—1 Navigation for Oracle Install Base Setups

Functions | Documents
Others:

Mass Edit Top Ten List
Transaction Errors Processing
Open Interface Error Details

- Setups

= Install Parameters -

Instance Relation Types
Party Account Relation Types
Transaction Types
Source Transactions Types
Extended Attribute Template
Instance Statuses
Asset Location Setup
Maintain Locations
Requests
Reports
Lookups
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2.5.1 Set Up Installation Parameters

Oracle Install Base keeps a set of customer-specific installation parameters defined
in a table at setup time. You use the Installed Parameters window to provide them.
After you define them and select Freeze, the fields cannot be updated.

The migration procedure populates the table with default data. After migration, you
open the window for update before the freeze takes effect.

Oracle Installed Base Admin responsibility: Setups > Install Parameters
The following list defines the fields in the Installed Parameters window.

= Party Name: The name of your own enterprise that you define in TCA as an
internal organization. It is the owner of the item instance when it is owned by
your own enterprise. Product transfers from this party are not supported. The
organization cannot be changed after it is set.

For new Oracle Install Base customers, this party can be first set up as an
internal party using Contact Center from the Oracle Customer Support
application. This party does not require an account number. This HZ_PARTY
can then be used in the Party Name field in the Install Base Parameter setup.

In the case of upgrades, this setup is done by setting the profile option Service:
Migration Organization for Employee Service Requests. This profile option
setting is only used during the upgrade process to populate the Party Name
field in the Install Parameters window. After the upgrade is complete, all
functionality refers to the value in the Party Name field of the Install
Parameters window and not to the profile option. For example: You buy and
receive an item in Oracle Receiving. The Oracle Install Base process that creates
the item instance assigns ownership of this new instance based on the Party
Name in the Install Parameters window.

Caution: Do not use this party as the object of a merge in TCA
merge routines.

= Full Dump Frequency: The number of updates of an Oracle Install Base record
before a full image of the record is dumped into the history table. For example,
HISTORY_FULL_DUMP_FREQUENCY=10 means that every 10th update
made to a record in any Oracle Install Base table is followed by a complete
dump of record's image (changed as well as unchanged columns) in the
corresponding history table. For the remaining nine updates, only the changed
values are dumped into the history table.
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Project Location (Address, City, State, and Zip): The location defined for the use
of instances in Project.

WIP Location (Address, City, State, and Zip): The location defined for use of
instances in WIP.

In-Transit Location (Address, City, State, and Zip): The location defined for use
of instances in transit between organizations.

PO Location (Address, City, State, and Zip): The location defined for use of
instances in WIP outside processing.

Category Set Name: The name of the category set to be used in the additional
attributes setup.

All Parties: If selected, then all parties and locations are made available for
transfer and location change. If it is not selected, then only related parties and
locations are made available for transfer and location changes.

Freeze: After this is selected, the parameters cannot be changed.

Allocate at WIP: If selected, conditionally allocates component quantities when
completing a multi-quantity assembly WIP job.

Some of the general conditions governing multi-quantity WIP assembly
completion configurations include:

»  Configurations are built based on job requirements.

= Configurations are only built for assemblies serialized at receipt or
predefined.

= If genealogy is enabled, configurations are created according to genealogy
or from the parent serial number.

Override Ownership: If selected, allows Oracle Install Base processing of RMA
receipts, order shipment, and miscellaneous receipts regardless of ownership.

For example:

In the case of an RMA receipt, Oracle Install Base processes the request even if
the RMA customer is different from existing instance ownership. Oracle Install
Base changes ownership to the RMA customer if the transaction subtype's
Change Owner To field is null.

For a miscellaneous receipt (serialized at-receipt or predefined) of an existing
Oracle Install Base instance, the ownership changes to Internal.
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Caution: By default, the Override Ownership checkbox is not
selected. After you select it and save one or more transactions, never
attempt to change it because doing so results in irrecoverable data
corruption.

= SFM Bypass: Replaces the previous CSE: Bypass Event Queue profile option.

Caution: Do not select this checkbox. The selected state is
reserved for internal testing purposes and is not recommended. For
further information, refer to the Oracle Enterprise Install Base
Implementation Guide.

Figure 2-2 Installed Parameters Window

~ Install Parameters

Party Name ||'o‘isiun Corporation Full Dump Fregquency ]
— Project Location ———— — WIP Locati
Address |Please refer to Project Job Address |Please refer to WIP Job Lc

| |

| |
City City
State State
Zip Zip

— In-Transit Location ———— — PO Location

Address |Please refer to In-Transit J Address |Please refer to PO Job Lot
City City
State State
Zip Tip
Category Set Name All Parties v Freeze (¥

Allocate at WIP W Owerride Ownership ¥ SFM Bypass [
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2.5.2 Set Up Codes for Party-Account and Party-Contact Relationship Types

The instance party account relationship codes define the types of relationship that
can be set up for parties, accounts, and contacts. The six seeded relationship types
are as follows:

Table 2-4 Seeded Relationship Types

Party Account Contact
Name Selected? Selected? Selected?
OWNER Y Y N
BILL-TO Y Y Y
SHIP-TO Y Y Y
SOLD-TO Y Y N
TECHNICAL N N Y
SERVICE-ADMINISTRATION N N Y

You can set up additional relationship type codes for party, account, and contact
and define them by selecting the appropriate Party, Account, and Contact
checkboxes in the Instance Party Account Relationship Types window.

For more information about setting up these codes, consult the Oracle TeleService
Implementation Guide.

2.5.3 Verify Codes for Instance Relationship Types

Oracle Install Base supports the eight types of instance-to-instance relationships
shown in Table 2-5.

Table 2-5 Relationship Type Codes

RELATIONSHIP TYPE RELATIONSHIP
CODE NAME DIRECTION
COMPONENT-OF Component Of Subject-to-Object
MEMBER-OF Member Of Subject-to-Object
PROVIDED-BY Provided By Subject-to-Object
INSTALLED-ON Installed On Subject-to-Object
CONNECTED-TO Connected To Bi-directional
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Table 2-5 Relationship Type Codes

RELATIONSHIP TYPE RELATIONSHIP
CODE NAME DIRECTION
UPGRADED-FROM Upgraded From Subject-to-Object
REPLACEMENT-FOR Replacement For Subject-to-Object
[for transaction only]

REPLACED-BY Replaced By Subject-to-Object

[for transaction only]

Component-of is the only relationship type that supports the flow-down of the
current location and the installation location from parent to child.

From the Oracle Order Management-Oracle Install Base shipment/fulfillment
integration, component-of configuration can be created through the BOM explosion,
PTO model, and ATO model. Refer to Section 1.3.4 for details on this integration.

From the WIP-Oracle Install Base integration, component-of configuration can be
created through the WIP assembly completion into inventory. Refer to Section 1.3.5
for details on this integration.

Replaced-by and replacement-for relationship types are created only by the Oracle
Order Management-Oracle Install Base integration using the Transaction Details
window. They are set up as transaction only. For further information, refer to
"Using the Transaction Details Window" in Oracle Install Base User Guide.

All other relationship types can be used in setting up multiple relationship types for
the same instance. No location flow-down rules apply.

Verify that the standard instance statuses are seeded by checking the content of the
Instance-Instance Relation Type Codes window.

2.5.4 Verify Extended Attribute-Level Codes
Type: CSI Lookup

Lookup Type: CSI_IEA_LEVEL_CODE
Access Level: System (non-extensible)

Verity that the following values are already seeded for CSI_IEA_LEVEL_CODE
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Table 2—6 describes the four levels of extended attributes that you can define for
Oracle Install Base items. These are the extended attributes that are used in the
Extended Attribute page of the application.

Table 2-6 Levels of Extended Attributes for Oracle Install Base Items

Lookup Code  Meaning Description

GLOBAL Global Applicable to all item instances in
Oracle Install Base

CATEGORY Category Applicable to the items of the
category for which the extended
attributes are defined

ITEM Item Applicable to all instances of the
item type for which the extended
attribute is defined.

INSTANCE Instance Applicable only to the instance for
which the extended attribute is
defined.

Use the Install Base Lookups window to verify that these codes are seeded for type
CSI_IEA_LEVEL_CODE.

2.5.5 Set Up Extended Attribute Pools
Type: CSI Lookup
Lookup Type: CSI_EXTEND_ATTRIB_POOL
Access Level: Extensible
Values are not seeded for this code.

Optionally define extended attribute pools with code values such as color and
grade.

To set up extended attributes, the name and code of the attribute have to be set up
in the pool of attributes. This is where users can define an attribute’s name, code,
and description to be used in the LOV when the extended attribute is set up.

2.5.6 Set Up Extended Attribute Classifications
Type: CSI Lookup

Lookup Type: CSI_IEA_CATEGORY
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Access Level: Extensible
Values are not seeded for this code.
Optionally define extended attribute classifications such as chemical and physical.

To set up extended attribute classifications, the name and code of the attribute have
to be set up in the pool of attributes (see Section 2.5.5). Then each attribute can be
classified into category. This is the table to define the categories by which an
attribute can be classified from a LOV in the extended attribute setup.

2.5.7 Set Up Extended Attributes

The extended attributes used for Oracle Install Base item instances must be defined
in the Extended Attributes window.

Four levels of extended attributes can be defined for Oracle Install Base items:

= Global: Global Level Extended Attributes are applicable to all the item instances
in Oracle Install Base.

= Item Category: Category level extended attributes are applicable to the items of
the category for which the extended attributes are defined.

= Inventory Item: Item level extended attributes are applicable to all the instances
of the item type for which the extended attribute is defined.

= Instance: Instance level extended attributes are applicable only to the instance
for which the extended attribute is defined.

Use the Oracle Install Base Extended Attributes window to define these attributes.

2.5.8 Verify Accounting Classification Codes
Type: CSI Lookup
Lookup Type: CSI_ACCOUNTING_CLASS_CODE
Access Level: System (non-extensible)
Verify that the following values are already seeded for CSI_ACCOUNTING_
CLASS_CODE:

Table 2-7 Accounting Classification Codes

Lookup Code Meaning Description

INV Inventory Inventory
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Table 2-7 Accounting Classification Codes

Lookup Code Meaning Description
ASSET Asset Asset

WIP Work In Process Work In Process
PROJECT Project Project
CUST_PROD Customer Product Customer Product

2.5.9 Set Up Instance Type Codes
Type: CSI Lookup

Lookup Type: CSL_INST_TYPE_CODE
Access Level: Extensible
No values are seeded for CSI_INST_TYPE_CODE.

Define the instance type codes used by your organization. You can enter any value.
Examples of instance types are Hardware, Software, and Service. This code is an
optional classification for an instance and is used in the general attributes page in
the application.

2.5.10 Verify Codes for Instance Location Sources
Type: CSI Lookup
Lookup Type: CSI_INST_LOCATION_SOURCE_CODE
Access Level: System (non-extensible)
Verity that the following values are already seeded for CSI_INST_LOCATION_
SOURCE_CODE.

Table 2-8 Instance Location Source Codes

Lookup Code Meaning Description

HZ_LOCATIONS HZ Location The Location is defined in HZ_
LOCATIONS table.

HZ_PARTY_SITES HZ Party Site Item is at an external party site. The
location is defined in HZ_PARTY_SITES
table.
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Table 2-8 Instance Location Source Codes

Lookup Code Meaning Description

INTERNAL_SITE Internal Site Item is at an internal site. The location is
defined in HR_LOCATIONS table.

INVENTORY Inventory Item is in inventory.

IN_TRANSIT In-Transit Item is in Transit. Location is defined by
in-transit order line ID.

PO PO Location is defined in PO_LINES_ALL
table.

WIP Work in Process Item is in WIP.

PROJECT Project Item is in Project.

VENDOR_SITE Vendor Site Item is at a vendor site. Location is defined

in PO_VENDOR_SITES_ALL table.

These are the types of product locations that are supported in Oracle Install Base.

2.5.11 Verify Party Sources
Type: CSI Lookup
Lookup Type: CSI_PARTY_SOURCE_TABLE
Access Level: System (non-extensible)
Verity that the following values are already seeded for CSI_PARTY_SOURCE_
TABLE.

Table 2-9 Party Sources Codes

Lookup Code Meaning Description

HZ_PARTIES HZ_PARTIES Party is defined in HZ_PARTIES table.
PO_VENDORS PO_VENDORS Party is defined in PO_VENDORS table.
EMPLOYEE HR Employee Party is defined in Party is defined in PER_

ALL_PEOPLE_F table.

This table is not extensible. It defines the types of parties that are supported in
Oracle Install Base for an instance. For example, an owner can be a party (such as a
customer), an employee, or a vendor. A party that provides support can be a team
or a group.
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2.5.12 Set Up Codes for Instance-Operating Unit Relationship Types
Type: CSI Lookup
Lookup Type: CSI_IO_RELATIONSHIP_TYPE_CODE
Access Level: Extensible
Verify that the following values are already seeded for the CSI_IO_
RELATIONSHIP_TYPE_CODE

Table 2-10 Codes for Instance-Operating Unit Relationship Types

Lookup Code Meaning Description

SOLD_FROM Sold from The item is sold from this operating unit.
SERVICE_BILL_ Service billed from  The operating unit that gets the credit from
FROM Billing.

Define new instance-to-operating units codes specific to your organization. Oracle
Install Base has limited functionality behind this instance-operating unit
association. It is for information only. The SOLD-FROM relationship is created each
time an instance is sold from an operating unit.

2.5.13 Set Up Version Labels
Type: CSI Lookup

Lookup Type: CSI_INSTANCE_VERSION_LABELS

Access Level: Extensible

Verify that the following values are already seeded for CSI_INSTANCE_VERSION_
LABELS.

Table 2-11 Setup of Version Labels

Lookup Code Meaning Description
AS-CREATED As-Created As-Created
AS-MAINTAINED As-Maintained  As-Maintained
AS-ORDERED As-Ordered As-Ordered
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Define new version label codes to be used in your organization. This table of codes
is used as a source of the LOV for the profile option setup in Default Version Label.
It is used as a default when an instance is first created.

2.5.14 Set Up System Type Codes
Type: CSI Lookup

Lookup Type: CSI_SYSTEM_TYPE
Access Level: Extensible

When a system is created, a type can be selected from an LOV. This table is where
user-defined system types can be set up for use in the LOV.

Use the setup window to define system types for your organization. They are used
in the Systems page of the application to define systems.

2.5.15 Set Up Split Process Reasons
Type: CSI Lookup

Lookup Type: CSI_SPLIT_REASON_CODE

Access Level: User (Extensible)

No values are seeded for CSI_SPLIT_REASON_CODE
Define split reasons to be used in your organization.

When an instance with a quantity greater than 1 is split, a reason code can be
selected for the reason for the split. This is the window where the reason codes can
be set up for use in an LOV.

2.5.16 Verify Oracle Configurator Enabled Values
Type: CSI Lookup

Lookup Type: CSI_CONFIG_ENABLED_VALUES
Access Level: System (Non-Extensible)

This setup maintains the LOV for the profile option CSI: Configurator Enabled and
is used for integration with the Oracle Telecommunications Service Ordering
solution and the Oracle Configurator product. Values are system defined and
seeded.
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Verify that the following values are already seeded for CSI_CONFIG_ENABLED _
VALUES.

Table 2-12 Codes for Oracle Configurator Enabled Values

Lookup Code Meaning Description

NETWORK NetworkModels Network Models Only
Only

NEVER Never Never

2.5.17 Verify Instance Class Values
Type: CSI Lookup
Lookup Type: CSI_ITEM_CLASS
Access Level: System (Non-Extensible)

This setup maintains the LOV for the Instance Class field in the Service tab in the
Inventory Item setup. It is used for integration with the Oracle Telecommunications
Service Ordering solution and Oracle Configurator.

Confirm that the values in the following table are seeded for CSI_ITEM_CLASS.

Table 2-13 Codes for Instance Classes

Lookup
Code Meaning Description
LINK Link Items of this class are used to connect two other item

instances in Oracle Install Base.

2.5.18 Verify Values for the Resubmit Interface Process
Type: CSI Lookup

Lookup Type: CSI_RESUBMIT_OPTIONS
Access Level: System (Non-Extensible)

This setup maintains the LOV for the Oracle Install Base concurrent request
Resubmit Interface process.

Confirm that the values in the following table are seeded for CSI_RESUBMIT_
OPTIONS.
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Table 2-14 Codes for Resubmit Interface Options

Lookup

Code Meaning Description

ALL All All transactions

SELECTED Selected Selected transactions from the Error Re-Processing

window.

2.5.19 Verify Values for CSI: Propagate Systems Changes

Type: CSI Lookup
Lookup Type: CSI_SYSTEM_WINDOW_DISPLAY
Access Level: System (non-extensible)

This setup maintains the LOV for the profile option CSI: Propagate Systems
Changes - Window Display. The Maintain System window uses these values when
displaying a confirmation window.

Confirm that the values in the following table are seeded for CSI_SYSTEM_
WINDOW_DISPLAY.

Table 2-15 Codes for CSI: Propagate Systems Changes

Lookup Code Meaning Description
DISPLAY Always display ~ Always display
NO_DISPLAY-ALWAYS_CHANGE Do not display Do not display and always change
and always
change
NO_DISPLAY_NEVER_CHANGE Do not display Do not display and do not change.
and do not
change.

2.5.20 Set Up Regions for the Advanced Search Page

Type: CSI Lookup
Lookup Type: CSI_ADV_SEARCH_DEF_SHOW
Access Level: System (Non-Extensible)

Navigation: Unlike the case for most other CSI lookups, you must use the
Application Developer responsibility to navigate to Application Lookups >
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Application Object Library. The Application Object Library Lookups window
appears.

This setup lists regions that are shown by default in the Advanced Search page. At
the site level, customize the display of that page by removing or collapsing regions
as required.

Steps
1. Use the following table to confirm the seeded values for CSI_ADV_SEARCH_
DEF_SHOW.

2. Use the To column in the Effective Dates region to exclude a section from being
displayed in the Advanced Search page.

3. Indicate whether a remaining section appears in expanded mode by default by
entering SHOW (all uppercase) in its Description column. Otherwise the section
is collapsed on the Advanced Search page.

Table 2-16 Codes for the Advanced Search Page

Lookup Code Meaning Description
00100 CSI_GEN_ATTR SHOW
00200 CSI_PARTY SHOW
00300 CSI_PARTY_ACCOUNTS HIDE
00400 CSI_CURRENT_LOCATION SHOW
00500 CSI_INSTALLED_AT HIDE
00600 CSI_PARTY_CONTACT HIDE
00700 CSI_ORDERS HIDE
00800 CSI_ASSETS HIDE
00900 CSI_CONTRACT HIDE
01000 CSI_OTHER_INFO HIDE

2.5.21 Set Up the Results of the Search Products Page
Type: CSI Lookup

Lookup Type: CSI_PRODUCTS_TABLE_DEF_COLS

Access Level: System (Non-Extensible)
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Navigation: Unlike the case for most other CSI lookups, here you must use the
Application Developer responsibility to navigate to Application Lookups >
Application Object Library. The Application Object Library Lookups window
appears.

This setup customizes the display of the search results of the Search Products page
by indicating the display and order of viewable columns. (The result is stored
internally in the Product Search Results table.) The setup window shows the
enabled columns of the corresponding search results with their left-to-right order
indicated by their Description value.

Here are some definitions that explain how to use the window:

The Meaning column lists the prompt IDs of all column titles of the search
results.

Use the To column in the Effective Dates region to exclude a column from being
displayed by default in the search results. For example, if by default you do not
want to display Usage in the search results, then end date the corresponding
row in the lookup to exclude that column.

The Description column contains a numeric value that indicates the relative
order of a column in the search results. A column with a smaller number
appears to the left of a column with a bigger number. For example, if you set the
Description value for the Status column to 50 compared to 70 for the Quantity
column, then Status appears to the left of Quantity in the search results.

The To date, an end date, is of primary importance. Thus, if a a row is end
dated, then the Description value is disregarded.

The lookup does not affect the Item Description column, which always appears
as the leftmost column.

The following table lists the codes that are available to set up the results of the
Search Products page.

Table 2-17 Codes for the Search Products Page

Lookup Code Meaning Description
0010 CSIL_ITEMNUM 10
0015 CSIL_ITEMTYPE 15
0020 CSI_INSTANCE_NUMBER 20
0030 CSI_SERIALNUM 30
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Table 2-17 Codes for the Search Products Page

Lookup Code Meaning Description
0040 CSI_LOTNUM 40
0050 CSI_SYSTEM 50
0060 CSI_SYS_OP_UNIT 60
0070 CSI_TAG_NUMBER 70
0080 CSI_STATUS 80
0090 CSI_QUANTITY 90
0100 CSI_PRODUCT_TYPE 100
0110 CSI_RETURN_BY_DATE 110
0120 CSI_ACTUAL_RETURN_DATE 120
0125 CSI_SHIPPED_DATE 125
0130 CSI_USAGE 130
0140 CSI_SALES_ORDER_NUM 140
0150 CSI_SALES_ORDER_LINE 150
0160 CSI_SALES_ORDER_DATE 160
0170 CSI_PURCHASE_ORDER_NUM 170
0180 CSI_AGREEMENT_NAME 180
0190 CSI_INSTANCE_START_DATE 190
0200 CSI_INSTANCE_END_DATE 200
0210 CSI_OWNER_PARTY_NAME 210
0220 CSI_OWNER_PARTY_NUMBER 220
0230 CSI_OWNER_ACCT_NAME 230
0240 CSI_OWNER_ACCT_NUMBER 240
0250 CSI_INSTALLED_AT_LINE1 250
0260 CSI_INSTALLED_AT_LINE2 260
0270 CSI_INSTALLED_AT_LINE3 270
0280 CSI_INSTALLED_AT_LINE4 280
0290 CSI_INSTALLED_AT _CITY 290
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Table 2-17 Codes for the Search Products Page

Lookup Code Meaning Description

0300 CSI_INSTALLED_AT_STATE 300

0310 CSI_INSTALLED_AT_ 310
POSTALCODE

0320 CSI_INSTALLED_AT_ 320
COUNTRY

0330 CSI_VIEW_DETAILS 330

0340 CSI_VIEW_CONFIG 340

0350 CSI_ALL_DETAILS 350

0360 CSI_COPY_PRODUCT 360

2.5.22 Set Up Instance Statuses

Instance statuses are user-extendible and are defined using a combination of
settable checkboxes.

Table 2-18 CSl Instance Statuses

Status

Change Service Request
Name Terminate Allowed Allowed Allowed Predefined Updatable
Created N Y Y Y Y N
Expired Y Y N N Y N
Latest N Y Y Y Y N
Loaner N Y N Y Y N
Repaired N Y Y Y Y N
Replaced N N N N Y N
Replaced - No Return Y Y N N Y N
Replacement N Y Y Y Y N
Return for Y Y N N Y N
Replacement
Returned for Credit N Y N N Y N
Returned for Repair N Y Y N Y N
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Table 2-18 CSl Instance Statuses

Status

Change Service Request
Name Terminate Allowed Allowed Allowed Predefined Updatable
Returned for Upgrade N Y Y N Y N
Returned Loaner N Y N N Y N
Spare Part N Y Y Y Y N
Updated N Y Y Y Y N
Upgraded N Y Y Y Y N

There are 16 seeded statuses.

The meaning of the checkboxes is as follows:

Terminated: Sets the instance to be terminated.

Status Change Allowed: The status can be changed for an instance currently
bearing this status.

Service Allowed: Service contract can be active for the instance with this status.
If set to No, then the service contract will be called to terminate the contract

Requests Allowed: Service request can be created for an instance with this
status.

Pre-Defined: Seeded
Updatable: The checkboxes on this status can be updated
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Figure 2-3 Instance Statuses Window
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2.5.23 Set Up Source Transaction Types

Before any source transaction can be used in the LOV for a transaction subtype, it
must be defined in this setup. All integration sources and transaction types must be
defined here before they can be used to update Oracle Install Base. Values can be
seeded or user-defined.

Window Fields in the Source Transaction Types Region

Application Name: An LOV of Oracle Applications that can be set up to integrate
into Oracle Install Base.

Transaction Type: The user-defined name of the kind of transaction that integrates
with Oracle Install Base from the application named.

Transaction Name: The user-defined name of the transaction.
Description: The user-defined description of the transaction.
Source Object: Reserved is for future use.

In Out: Reserved for future use.
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Figure 2-4 Source Transaction Types Window
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2.5.24 Set Up Transaction Subtypes

Transaction types and subtypes are used to specify the kinds of transactions that the
interface program can use. The main purpose of the Source Transactions Subtypes
window is to specify what kind of update can be done to an Oracle Install Base
instance when transactions come from either ERP or CRM. For this release the data
comes from Oracle Order Management, Oracle Field Service, and Oracle Order
Capture. In Oracle Order Management you can go into the transaction relation
details to pick one of the transactions being defined here. Here you define these
transactions and the kind of actions they can perform on the source instance, the
non-source instance, and the parent instance.
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Figure 2-5 Source Transaction Subtypes Window
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This region is used to define the name of the transaction subtype. The name can
come form two sources, depending whether the Service Type checkbox is selected
or not:

»  If Service Type is selected, then the LOV comes from the Service Transaction
Billing Types setup.

= If Service Type is not selected, then the LOV comes from the Oracle Install Base
Transaction Type code setup. Refer to the section on "Transaction Subtype from
the Non-Service process."

The Name field provides the LOV from which you can select the name of the
transaction subtype.
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Source Info Region

This region is used to define the specific actions to take for the instance being
transacted. In the case of the sales order line, it can the part being sold on the sales
order line.

Reference Required: Specifies whether an Oracle Install Base product number or
reference number is mandated for this transaction type. In the case of a return of a
non-serialized item, this Oracle Install Base product number is always required for
the Oracle Install Base interface to know which instance to update. If the part is a
serialized item, then this product number is not mandated because the interface
program can pick up the serial number from the receipt transaction.

Change Owner: Indicates whether a change of ownership is to take place for this
transaction type. If checked, then a change of ownership is to take place.

Change Owner To: Selects the ownership change to be Internal or External. For
example, when returning an item for repair, the ownership need not be changed.
For a sales order of a shipped item, the ownership can be changed to External.

Status: Defines the status to be updated for this instance. For example, when an
instance is returned for repair, its status is changed to Returned for Repair.

Return Reqd: Requires a return date to be entered on the Installation detail for this
transaction. Not mandatory.

Revision Reqd: Requires a revision to be entered on the Installation detail for a
revision controlled instance. Not mandatory.

Non Source Info Region
This region is to define the specific actions to make for the instance being related to
the instance being transacted.

If the non-source installation detail uses the transaction subtype, then the action to
be taken for the non-source instance comes from this region. For example, in order
to use this subtype for a to-be-replaced instance in the non-source installation detail,
Reference Reqd must be selected, and a status specified.

Reference Reqd: Specifies whether an Oracle Install Base product number or
reference number is mandated for this transaction type.

Change Owner: Indicates whether a change of ownership is to occur for this
transaction type. If checked, then change of ownership is to occur.

Change Owner To: Selects the ownership change to be Internal or External.
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Status: Defines the status to be updated for this instance. For example, the status of
a replaced instance can be Replaced.

Return Required: Requires a return date to be input on the transaction detail for this
transaction.

Parent Info Region

This region is for future use. Thus, the Reference Reqd, Status, and Revision Reqd
fields are not currently used.

Transaction Sub Types Region

The tab ordering of the fields in the window now returns to this region to the Freeze
and Seeded checkboxes.

Source Transaction Types Region

This region is to define the source application from which the transaction being
defined comes.

This is a LOV of transaction types defined first in the Source Transaction Type
setup. For example, the Sell transaction subtype comes from the Oracle Order
Management application OM_SHIPMENT. Return for Credit comes from the Oracle
Order Management application RMA_RECEIPT type.

Other examples of application sources are Oracle Field Service and Oracle Order
Capture.

The In Out field is not being used for this release.

Default: Indicates whether this transaction subtype is to be used as the default
subtype for that source transaction type and application being defined. For
example, Sell is the default subtype for OM_SHIPMENT/ Order Management
Ship/Fulfill sales order lines. Return for Repair is the default subtype for the RMA _
RECEIPT/ Order Management Return line.

Update IB: Indicates whether this subtype/source transaction type combination is
used to update Oracle Install Base or not. For example, some subtypes set up for the
Oracle Field Service application updates Oracle Install Base only from Oracle Field
Service.

2.5.25 Set Up the Transaction Subtypes LOV from Non-Service Processes
Type: CSI Lookup

Lookup Type: CSI_IB_TXN_TYPE_CODE
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If the Service Type checkbox of the Source Transactions Subtypes window is not
selected, then the LOV comes from the Oracle Install Base Transaction Type Codes
setup.

This setup is found in the Oracle Install Base Administrator /Lookup/ CSI_IB_
TXN_TYPE_CODE table. Six seeded values are used in the transaction subtype
setup, and more can be user-defined.

Use the following table to confirm the seeded values for CSI_IB_TXN_TYPE_CODE.

Table 2-19 Codes for CSI_IB_TXN_TYPE_CODE

Lookup

Code Meaning Description
ADD Add Add
FULFILL Fulfill Fulfill
ISSUE Issue Issue
MOVE Move Move
RECEIVE Receive Receive
SELL Sell Sell

2.5.26 Verify Transaction Status Codes

Type: CSI Lookup
Lookup Type: CSI_TRANSACTION_STATUS_CODE
Access Level: System

Values are seeded for this code.

Use the following table to confirm the seeded values for CSI_IB_TXN_TYPE_CODE.

Table 2-20 Transaction Status Codes

Lookup Code Meaning Description
COMPLETE Complete No further FA/PA processing
INTERFACED Interfaced to PA  PA transaction interfaced

PENDING Pending Need further FA /PA processing
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2.5.27 Verify Transaction Error Source Types
Type: CSI Lookup
Lookup Type: CSI_TXN_ERRORS_SOURCE_TYPES
Access Level: System
Values are seeded for this code.

When an integration transaction is processed with an error, it is posted to the error
table with one of the these error source types, which indicate where an error comes
from.

Use the following table to confirm the seeded values for CSI_TXN_ERRORS_
SOURCE_TYPES.

Table 2-21 Transaction Status Codes

Lookup Code Meaning Description

AP_INVOICE_ AP Invoice Distribution All For the AP invoice distribution
DISTRIBUTIONS_ALL events.

EIB_NOTIFICATIONS EIB Notifications Indicates that the message is a

notification generated by
Oracle Enterprise Install Base
during transaction processing.

FA_RETIREMENTS FA Retirements For the asset retirement and
asset reinstatement events.
MIL_MATERIAL _ MIL Material Transactions For all inventory-related
TRANSACTIONS events.
RCV_TRANSACTIONS RCV Transactions For the purchase order

received into project event.

WFM_TRANSACTIONS WZFM Transactions For all workforce management
related events including
equipment installed,
equipment in service, asset in
service, asset out of service,
and item move.

2.5.28 Create Business Users

Oracle Install Base supports many different permissions with specific access and
update privileges. See Table 2-22 for supported permissions.
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A role is a combination of permissions. Oracle Install Base ships with two
pre-defined roles: CSI_END_USER for business users and CSI_NORNAL_USER for
internal agent users.

Create business users as needed for Oracle Install Base. To do so, you must create
business users and assign them the predefined CSI_END_USER role and the
responsibility of an Oracle Install Base customer. For details on creating users and
assigning associated accounts, roles, and responsibilities, refer to the user
management sections of the Oracle Common Application Components User’s Guide. To
confirm your user management work, log in to the Oracle E-Business Suite login
(jtflogin) with the user name and password that you established, and everything
should be set. The accounts that you assigned should be what appear as the list of
accounts associated with this user in the customer UL It may be a subset because
JTF shows all accounts regardless of active or inactive status whereas the Oracle
Install Base window shows only the active accounts that are associated with a user.

Table 2-22 Permissions Supported by Oracle Install Base

Name Description Agent Customer
CSI_ACCT_ACCESS_  Restricts the users access to Oracle Install Base N Y
ONLY products based on an Account

CSI_ADDI_ATTR_ Update permission for the CSI Additional Attributes Y Y
UPDATE page.

CSI_ADDI_ATTR_ View permission for the CSI Additional Attributes Y Y
VIEW page.

CSI_ALL_ACCT_ Allows access to Oracle Install Base Products across Y N
ACCESS accounts and parties.

CSI_ASSET_UPDATE Update permission for the Asset page Y N
CSI_ASSET_VIEW View permission for the Asset page Y N
CSI_CONTACT_ Update permission for the Contact Detail page Y Y
DETAIL_UPDATE

CSI_CONTACT_ View permission for the Contact Detail page Y Y
DETAIL_VIEW

CSI_CONTRACT_ Update permission for the Contract page Y Y
UPDATE

CSI_CONTRACT_ View permission for the Contract page Y Y
VIEW

CSI_COUNTER_ Update permission for the Counter page Y Y

UPDATE
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Table 2-22 Permissions Supported by Oracle Install Base

Name Description Agent Customer
CSI_COUNTER_VIEW View permission for the Counter page Y Y
CSI_CREATE_INST_  Update permission for the Create Instance page Y Y
UPDATE
CSI_CREATE_INST_  View permission for the Create Instance page Y Y
VIEW
CSI_CREATE_SYS_ Update permission for the CSI Create System page Y N
UPDATE
CSI_CREATE_SYS_ View permission for the CSI Create System page Y N
VIEW
CSI_CUSTOMER _ This permission should be assigned to any user that N Y
VIEW is a customer
CSI_DOWNLOAD Permission to download product search results. Y Y
CSI_EXPIRE_ Users with this permission can change the instance Y Y
INSTANCE status to any terminable status. The user also needs

to have the CSI_INST_STATUS_UPDATE

permission.
CSI_GENERAL _ Makes certain Customer product attributes read only N Y
ATTRIB_CUST_ONLY
CSI_INST_CONFIG_  Update permission for the Instant Config page Y Y
UPDATE
CSI_INST_CONFIG_  View permission for the Instant Config page Y Y
VIEW
CSI_INST_GENERAL_ Update permission for the Instant General page Y Y
UPDATE
CSI_INST_GENERAL_ View permission for the Instant General page Y Y
VIEW
CSI_INST_NOTES_ Permission to update the Oracle Install Base instance Y Y
UPDATE notes.
CSI_INST_NOTES_ Permission to view the Oracle Install Base instance Y Y
VIEW notes.
CSI_INST_ Users with this permission are allowed to update Y Y
QUANTITY_UPDATE instance quantity
CSI_INST_STATUS_ Users with this permission can update the instance Y Y

UPDATE

status
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Table 2-22 Permissions Supported by Oracle Install Base

Name Description Agent Customer
CSI_LATEST_ Update permission for the Latest Transaction page Y Y
TRANSACTION_

UPDATE

CSI_LATEST_ View permission for the Latest Transaction page Y Y
TRANSACTION_

VIEW

CSI_MERCHANT_ this permission should be assigned to any user thatis Y N
VIEW an agent of a merchant

CSL_ Update permission for the Operating Unit page. Y N
OPERATINGUNIT_

UPDATE

CSL_ View permission for the Operating Unit page. Y N
OPERATINGUNIT_

VIEW

CSIL_ Permission to view organizations Y N
ORGANIZATION_

VIEW

CSI_PARTY_ Update permission for the Party Account page Y N
ACCOUNT_UPDATE

CSI_PARTY_ View permission for the Party Account page Y N
ACCOUNT_VIEW

CSI_PARTY_ Update permission for the Party Contact page Y Y
CONTACT_UPDATE

CSI_PARTY_ View permission for the Party Contact page Y Y
CONTACT_VIEW

CSI_PARTY_ Update permission for the Party Summary page Y N
SUMMARY_UPDATE

CSI_PARTY_ View permission for the Party Summary page Y N
SUMMARY_VIEW

CSI_PARTY_UPDATE Update permission for the Party page Y N
CSI_PARTY_VIEW View permission for the Party page Y N
CSI_PERZ_EDIT_ Update permission for the Personalized Edit page Y Y
UPDATE

CSI_PERZ_EDIT_ View permission for the Personalized Edit page Y Y

VIEW
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Table 2-22 Permissions Supported by Oracle Install Base

Name Description Agent Customer
CSI_PRICING_ Update permission for the Pricing page Y Y
UPDATE

CSI_PRICING_VIEW  View permission for the Pricing page Y Y
CSI_PROPERTY_ Read the CSI Properties Y Y
READ

CSI_PROPERTY_ Update the CSI Properties N N
UPDATE

CSI_REPAIR_ORDER_ Update permission for the Repair Order page Y Y
UPDATE

CSI_REPAIR_ORDER_ View permission for the Repair Order page Y Y
VIEW

CSI_SEARCH_ASSET_ Update permission for the Search Asset Result page Y N
RES_UPDATE

CSI_SEARCH_ASSET_ View permission for the Search Asset Result page Y N
RES_VIEW

CSI_SEARCH_ASSET_ Update permission for the Search Asset page Y N
UPDATE

CSI_SEARCH_ASSET_ View permission for the Search Asset page Y N
VIEW

CSI_SEARCH_ Update permission for the Search Product page Y Y
PRODUCT_UPDATE

CSI_SEARCH_ View permission for the Search Product page Y Y
PRODUCT_VIEW

CSI_SEARCH_SYS_ Updating systems search results. Y N
UPDATE

CSI_SEARCH_SYS_ Viewing the systems search page. Y N
VIEW

CSI_SEARCH_ Update permission for the Search Transaction page Y N
TRANSACTION_

UPDATE

CSI_SEARCH_ View permission for the Search Transaction page Y N
TRANSACTION_

VIEW

CSI_SERVICE_ Update permission for the Service Request page Y Y

REQUEST_UPDATE
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Table 2-22 Permissions Supported by Oracle Install Base

Name Description Agent Customer
CSI_SERVICE_ View permission for the Service Request page Y Y
REQUEST_VIEW

CSI_SHOW_ALL_ Allows an Oracle Install Base user to view all types Y N
CONTACTS of contacts

CSI_SHOW_ALL_ Allows an Oracle Install Base user to view all types Y N
LOCATIONS of locations

CSI_SHOW_ALL_ Allows the user to View all types of parties including Y N
PARTIES Employees CSI

CSI_SHOW_EXT_ Restricts an Oracle Install Base user to view only the N Y
CONTACTS external contacts

CSI_SHOW_EXT_ Restricts an Oracle Install Base user to view only N Y
LOCATIONS external locations

CSI_SHOW_EXT_ Restricts the user to View only the External parties N Y
PARTIES

CSI_SHOW_INST _ Permission to have the Oracle Install Base Customer N Y
CUSTOMER_MENU facing instance details Menu

CSI_SHOW_INST_ Permission to have the Oracle Install Base Agent Y N
MENU facing instance details Menu

CSI_SPLIT_ Update permission for the Split Quantity page Y Y
QUANTITY_UPDATE

CSI_SPLIT_ View permission for the Split Quantity page Y Y
QUANTITY_VIEW

CSI_SYS_CFG_VIEW  Viewing Systems configurations. Y Y
CSI_SYS_DTL_ Update permission for the CSI System Detail page Y Y
UPDATE

CSI_SYS_DTL_VIEW  View permission for the CSI System Detail page Y Y
CSI_TABLE_PERZ_ Update permission for the Table Personalized page Y N
UPDATE

CSI_TABLE_PERZ_ View permission for the Table Personalized page Y N
VIEW

CSI_TRANSACTION_ Update permission for the Transaction Detail page Y Y
DETAIL_UPDATE

CSI_TRANSACTION_ View permission for the Transaction Detail page Y Y

DETAIL_VIEW
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Table 2-22 Permissions Supported by Oracle Install Base

Name Description Agent Customer
CSI_TRANSACTION_ Update permission for the Transaction Instance page Y Y
INSTANCE_UPDATE

CSI_TRANSACTION_ View permission for the Transaction Instance page Y Y
INSTANCE_VIEW

CSI_TRANSFER _ Update permission for the Transfer Owner page Y N
OWNER_UPDATE

CSI_TRANSFER_ View permission for the Transfer Owner page Y N

OWNER_VIEW

2.5.29 Create Agent Users

Create agent users as needed for Oracle Install Base. To do so, you must create
internal users and assign them the predefined CSI_NORMAL_USER role and the
responsibility of an Oracle Install Base user. For details on creating users and
assigning associated accounts, roles, and responsibilities, refer to the user
management sections of the Oracle Common Application Components User’s Guide.

2.5.30 Schedule the Expire End Dated Instances Program

This program goes through the end dates set up for instances to be expired. If the
end date is past due, then the instances are set to expire. Schedule this program to
run at least once a day. To schedule the program:

Steps

1.

Login as Oracle Installed Base Admin in the forms mode.
The Navigator window appears.

Chose Others > Requests.

The Submit a New Request window appears.

Select Single Request, and click OK.

The Installed Base Requests window appears.

From the Name LOV, select Expire End Dated Instances.
Click OK.

In the At these Times region, click Schedule.
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The Schedule window appears.

Select the desired running schedule.

Click OK.

The Installed Base Requests window appears.

Click Submit.

2.5.31 Schedule the Install Base Open Interface Program

This program imports significant volumes of data into Oracle Install Base
application tables through its mass load feature. Through its incremental load
feature, it synchronizes Oracle Install Base with subsystems by importing item
instances from different feeder systems on a frequent, on-going basis. Through its
change functionality, it automates the process of adding as well as updating
changes to the attributes of item instances. It also validates imported data to ensure
data integrity with Oracle applications. To schedule the program:

Steps

1.

Login as Oracle Installed Base Admin in the forms mode.
The Navigator window appears.

Chose Others > Requests.

The Submit a New Request window appears.

Select Single Request, and click OK.

The Installed Base Requests window appears.

From the Name LOV, select either Install Base Open Interface or Install Base
Open Interface - Parallel Concurrent Workers.

Click OK.

In the At these Times region, click Schedule.
The Schedule window appears.

Select the desired running schedule.

Click OK.

The Installed Base Requests window appears.

Click Submit.
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2.5.32 Schedule the Initiate Mass Edit Program

This program polls the submitted mass edit sessions and calls the Process Mass Edit
program to process eligible sessions. In order to process mass edit transactions, run
the Initiate Mass Edit concurrent program or schedule it to run at a regular
intervals. Oracle recommends that you schedule it to run at least once a day. To
schedule the program:

Steps
1. Login as Oracle Installed Base Admin in the forms mode.
The Navigator window appears.
2. Chose Others > Requests.
The Submit a New Request window appears.
3. Select Single Request, and click OK.
The Installed Base Requests window appears.
4. From the Name LOV, select Initiate Mass Edit.
5. Click OK.
6. In the At these Times region, click Schedule.
The Schedule window appears.
7. Select the desired running schedule.
8. Click OK.
The Installed Base Requests window appears.
9. Click Submit.

2.5.33 Schedule the Process Mass Edit Program

This is the program that is called automatically to process the mass edit sessions.
Schedule it to run at a regular interval to pick up mass edit sessions due to be
processed. To schedule the program:

Steps
1. Login as Oracle Installed Base Admin in the forms mode.
The Navigator window appears.

2. Chose Others > Requests.

2-48 Oracle Install Base Implementation Guide



Setup Steps within Oracle Install Base

The Submit a New Request window appears.

Select Single Request, and click OK.

The Installed Base Requests window appears.

From the Name LOV, select Process Mass Edit Transaction.
Click OK.

In the At these Times region, click Schedule.

The Schedule window appears.

Select the desired running schedule.

Click OK.

The Installed Base Requests window appears.

Click Submit.

2.5.34 Schedule the Process Old Order Lines-Fulfillable Only Program

This program processes the old fulfillable order lines migrated from previous
versions of Oracle Install Base. Run it once or twice a day for the month after you
migrate. To schedule the program:

Steps

1.

Login as Oracle Installed Base Admin in the forms mode.

The Navigator window appears.

Chose Others > Requests.

The Submit a New Request window appears.

Select Single Request, and click OK.

The Installed Base Requests window appears.

From the Name LOV, select Process Old Order Lines-Fulfillable Only.
Click OK.

In the At these Times region, click Schedule.

The Schedule window appears.

Select the desired running schedule.
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8.

9.

Click OK.
The Installed Base Requests window appears.

Click Submit.

2.5.35 Schedule the Resubmit Interface Process

This program processes the transactions in the Error processing table. It can be set
up to process selected lines or all lines in the table. This program can be called to
run by user request or can set up to run at a regular interval. To schedule the
program:

Steps

1.

Login as Oracle Installed Base Admin in the forms mode.
The Navigator window appears.

Chose Others > Requests.

The Submit a New Request window appears.

Select Single Request, and click OK.

The Installed Base Requests window appears.

From the Name LOV, select Resubmit Interface Process.
Click OK.

In the At these Times region, click Schedule.

The Schedule window appears.

Select the desired running schedule.

Click OK.

The Installed Base Requests window appears.

Click Submit.

2.5.36 Schedule the Resubmit Waiting Transactions Program

This program processes the transactions that are set as waiting status in the Oracle
Install Base update process. The program can be scheduled to run at a regular
interval. To schedule the program:

Steps
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1. Login as Oracle Installed Base Admin in the forms mode.
The Navigator window appears.
2. Chose Others > Requests.
The Submit a New Request window appears.
3. Select Single Request, and click OK.
The Installed Base Requests window appears.
4. From the Name LOV, select Resubmit Waiting Transactions.
5. Click OK.
6. In the At these Times region, click Schedule.
The Schedule window appears.
7. Select the desired running schedule.
8. Click OK.
The Installed Base Requests window appears.

9. Click Submit.

2.5.37 Final Synchronize On-Hand Balance with Oracle Inventory

To maintain life-cycle tracking for all items that are to be tracked in Oracle Install
Base, it maintains a mirror image of what is in Inventory. For new implementations
of Oracle Install Base, all on-hand quantities of the Oracle Install Base trackable
items were issued out of Oracle Inventory in Step 1 of the checklist. Now you must
receive them back into Oracle Inventory. You must ensure that the Service
Fulfillment Manager queue is up and running before attempting this step. Oracle
suggests that you use the miscellaneous receipt transaction in Inventory to do this
step.

Refer to the steps in Oracle Service Fulfillment Manager User Guide to start and make
sure that the Oracle Service Fulfillment Manager queue is up and running.
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Implementation and Setup for Upgrade
Users

This chapter provides implementation and setup information for users who have an
earlier version of Oracle Install Base and are upgrading to this version. Because you
are an upgrade user, the application automatically updates much of your current
setup. Therefore you are required to consider only a subset of the setup steps
required for a new user.

This chapter covers the following topics:
= Product Dependencies and Requirements

= Setup Checklist for Upgrade Users

3.1 Product Dependencies and Requirements

The following modules must be installed and set up for Install Base to work. Refer
to the appropriate guides to install and set up these modules:

s Oracle Inventory

s Oracle Enterprise Install Base

= Oracle Service Fulfillment Manager
s Oracle Order Management

s Oracle Purchasing (Optional)

= Oracle Accounts Receivable

= Oracle Work in Process (Optional)

= Oracle Bills of Material
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3.2 Setup Checklist for Upgrade Users

This following table provides a checklist of setup steps for upgrade users of Oracle
Install Base. The entries for section reference in the table direct you to Chapter 2 for
detailed step descriptions.

Table 3-1 Setup Checklist for Upgrade Users of Oracle Install Base

Step Required or Section
Number Title Optional Seeded? Extensible? Reference
1. Set Up Inventory Serial Required NA NA Section 2.3.2

Control at the Master
Level
2. Set Up Oracle Install Base =~ Required NA NA Section 2.3.3
Items in the Item Master
3. Set Up Vendors Optional N N Section 2.3.5
4. Set Up Employees Optional N N Section 2.3.6
5. Verify the Setup of the Required N N Section 2.3.9

Oracle Service Fulfillment
Manager Event Queue

6. Set Up the Action Menuin Required N N Section 2.3.10
Oracle Order Management
7. Set Up the Order Required N N Section 2.3.11

Management Workflow for
Non-Shippable Items

8. Run the License Manager  Required N N Section 2.4.1
Program
9. Verify the Setup of Four Required N N Section 2.4.2

Profile Options for Oracle
Enterprise Install Base

10. Verify Location IDs in HZ_  Required Y N Section 2.4.3
LOCATIONS

11. Verify Codes for Asset Optional Y N Section 2.4.4
Update Statuses

12, Set Up Codes for Required Y Y Section 2.5.2

Party-Account and
Party-Contact Relationship

Types
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Table 3-1 Setup Checklist for Upgrade Users of Oracle Install Base

Step Required or Section
Number Title Optional Seeded? Extensible? Reference
13. Verify Codes for Instance ~ Required Y N Section 2.5.3
Relationship Types

14. Verify Extended Required Y N Section 2.5.4
Attribute-Level Codes

15. Set Up Extended Attribute Optional N Y Section 2.5.5
Pools

16. Set Up Extended Attribute Optional N Y Section 2.5.6
Classifications

17. Set Up Extended Optional N Y Section 2.5.7
Attributes

18. Verify Accounting Required Y N Section 2.5.8
Classification Codes

19. Verify Codes for Instance ~ Required Y N Section 2.5.10
Location Sources

20. Verify Party Sources Required Y N Section 2.5.11

21. Set Up Codes for Required Y Y Section 2.5.12
Instance-Operating Unit
Relationship Types

22, Set Up the Transaction Required Y N Section 2.5.25
Subtypes LOV from
Non-Service Processes

23. Verify Transaction Error Required Y N Section 2.5.27
Source Types

24, Verify Oracle Configurator Required Y N Section 2.5.16
Enabled Values

25. Verify Instance Class Required Y N Section 2.5.17
Values

26. Verify Values for the Required Y N Section 2.5.18
Resubmit Interface Process

27. Verify Values for CSI: Required Y N Section 2.5.19
Propagate Systems
Changes

28. Set Up Regions for the Optional Y N Section 2.5.20
Advanced Search Page
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Table 3-1 Setup Checklist for Upgrade Users of Oracle Install Base

Step Required or Section
Number Title Optional Seeded? Extensible? Reference
29, Set Up the Results of the Optional Y N Section 2.5.21
Search Products Page

30. Create Business Users Required N N Section 2.5.28

31. Create Agent Users Required N N Section 2.5.29

32. Schedule the Install Base Required N N Section 2.5.31
Open Interface Program

33. Schedule the Initiate Mass Required N N Section 2.5.32
Edit Program

34. Schedule the Process Mass Required N N Section 2.5.33
Edit Program

35. Schedule the Process Old ~ Required N N Section 2.5.34
Order Lines-Fulfillable
Only Program

36. Schedule the Resubmit Required N N Section 2.5.35
Interface Process

37. Schedule the Resubmit Required N N Section 2.5.36

Waiting Transactions
Program
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4

Oracle Install Base System Profile Options

and Debug Information

4.1 Oracle Install Base System Profile Options

Table 4-1 describes the profile options for Oracle Install Base. These profile options
are to be set at the site level.

Table 4-1 Profile Options for Oracle Install Base

Profile Option Name

Comments

CSI: Allow Install
Parameter Update

CSI: Auto-Generate
System Name

CSI: Auto-split Instances
During Instantiation

CSI: BOM Explosion Level

CSI: Cascade System
Termination

Use this profile option with great caution. The default = N. Do not
alter this setting unless instructed to do so as part of patching
or by Oracle Customer Support or Development. Changing the
default can cause irrecoverable data corruption. (This profile
option is set to Y after migration to allow a one-time update to
install parameters. Then it is set to N.)

For more information, refer to the discussion of the Override
Ownership checkbox in Section 2.5.1, "Set Up Installation
Parameters" on page 2-16.

Auto-generate System Number at time of system creation (Y or
N).

Auto split instances with multiple quantity to 1 per instance at
time of instance creation (Y or N).

Number of BOM levels to explode for creation of component-of
configuration from BOM setup (1, 2, 3.). Note that BOM
explosion stops at any level where child is at quantity > 1.

Cascade system termination to instances (Y or N).
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Table 4-1 Profile Options for Oracle Install Base

Profile Option Name

Comments

CSI: Configurator Enabled
CSI: Contracts Enabled

CSI: Counters Enabled
CSI: Debug Level

CSI: Default Instance
Status

CSI: Default Version Label

CSI: Display HTML UI

CSI: Enable Contracts For
Open Interface

CSI: Enable SQL Trace
CSI: Explode BOM

CSI: Filter Display of all
Contracts

CSI: Forms to SSWA
Default Responsibility

CSI: Instance Termination
Status

CSI: Log file Name
CSI: Log File Path

CSI: OE Line Processing
Delay

CSI: Open Interface
Commit Record Limit
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Default = Network Models Only. Used for integration with the
TSO solution and the Oracle Configurator product.

Enable Oracle Install Base integration with Oracle Service
Contracts (Y or N).

Enable Oracle Install Base integration with Counters (Y or N).
For Debug, set at 9 or 10 for Debug to start.

Default Instance Status at time of instance creation. Pick one
status from the LOV.

Default version label at time of instance creation. Pick one from
the LOV.

Option to use Oracle Install Base HTML for display (Internal).
Used by other CRM applications to use the Oracle Install Base
HTML UI (Y or N).

Default = N. A setting of Y means that the Oracle Service
Contracts application creates Service Warranties where
applicable during an Open Interface run. Setting the profile
option to N imports data faster than when it is set to Y.

For Debug (Y or N). Set to Y to start Debug.

Enable BOM explosion for top assembly with Oracle Install
Base trackable components at time of shipment/fulfillment (Y
or N).

Default = N. If set to Y, the application displays only active
contracts.

Default user for applications to launch HTML from forms.
Default Installed Base User or from the LOV.

Default Termination Status. Pick one from the LOV.

The name of the log file for Debug.
For Debug ('utl-file-dir' parameter in init.ora).

Delay between OE line processing. Time between order line
processing to allow for Oracle Install Base update completion
to avoid record locking. Recommended delay: 60 seconds.

Used to commit Open Interface transactions to the data base.
Default = 1000.



Oracle Install Base System Profile Options

Table 4-1 Profile Options for Oracle Install Base

Profile Option Name

Comments

CSI: Propagate System
Changes

CSI: Propagate Systems
Changes - Window
Display

CSI: Restrict LOV’s on Site
Usage.

CSI: Show Expired
Instances

CSI: Stop At Debug Errors

CSI: System Name Update
Allowed

CSI: UI Default Selection
of View Details Dropdown

SERVICE Master
Inventory Validation
Organization

Propagate system changes to instances (Y or N).

Condition of propagating system changes to products when
Propagate System Changes is set to "Y":

= Always Display: Change only when the system info
matches the product information.

= Always Change: Do not display and always change.
= Never Change: Do not display and do not change:

Default = N. Set at Site Level. For value =Y, the application
restricts the Installed Locations LOV in the Systems page to
customer addresses with locations identified as Install At.

Default = N. Enables users to default the value of the Show
Expired Products checkbox in the Advanced Search page. If the
profile option value =Y, then the application shows all
instances including expired products in the Oracle Install Base
UL

Set to Y to start debug (Y or N).

System name update allowed after system name creation (Y or
N).

Defines the default link populated in the ‘speed menu’ for
summary results displayed in the Search Products page.

Replaces the ASO: Product Organization profile option
obsoleted in a prior release.

During the upgrade process, the inventory organization
specified in this profile is used to upgrade customer products
manually created in Oracle Service.

After upgrade, this inventory organization is used to validate
whether an item is trackable in Oracle Install Base and to
derive other item parameters such as serialization when you
create new item instances using Oracle Install Base.

Oracle strongly recommends that you set this to a master
inventory organization.
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4.2 Setting the Debug Option

Oracle Install Base provides an option to write debug information in a log file. By
default, the debug feature is turned off. To turn the debug option off, change the
profile option CSI_DEBUG_LEVEL value to 0.

To turn the debug option on, perform the following steps:

Steps

1.
2.

Change the value of profile option CSI_DEBUG_LEVEL to either 9 or 10.

Specify the value of the profile option CSI_LOGFILE_PATH to be the path of
the directory on the server side where the log file should be written.

You must choose the log file path from the list of paths defined for the
parameter utl_file_di in the init.ora file. Alternatively, you can run the sql
statement SELECT value FROM vSparameter WHERE name = 'utl_
file dir'.

Specify the value of profile option CSI_LOGFILE_NAME to be the name you
want to give to the log file.

The specified log file will be written in the CSI_LOGFILE_PATH directory on
the server side, and all debug messages will be written to this file. Each message
in the log file will have the session ID and username attached to it.

Use these settings as required:
= CSIStop At Debug Errors: Set to Y to start Debug.
s CSI Enable SQL Trace: Set to Y to start Trace.
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